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Technical Support
Symantec Technical Support maintains support centers globally. Technical
Support’s primary role is to respond to specific queries about product features
and functionality. The Technical Support group also creates content for our online
Knowledge Base. The Technical Support group works collaboratively with the
other functional areas within Symantec to answer your questions in a timely
fashion. For example, the Technical Support group works with Product Engineering
and Symantec Security Response to provide alerting services and virus definition
updates.

Symantec’s support offerings include the following:

■ A range of support options that give you the flexibility to select the right
amount of service for any size organization

■ Telephone and/or Web-based support that provides rapid response and
up-to-the-minute information

■ Upgrade assurance that delivers software upgrades

■ Global support purchased on a regional business hours or 24 hours a day, 7
days a week basis

■ Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our Web site
at the following URL:

www.symantec.com/business/support/

All support services will be delivered in accordance with your support agreement
and the then-current enterprise technical support policy.

Contacting Technical Support
Customers with a current support agreement may access Technical Support
information at the following URL:

www.symantec.com/business/support/

Before contacting Technical Support, make sure you have satisfied the system
requirements that are listed in your product documentation. Also, you should be
at the computer on which the problem occurred, in case it is necessary to replicate
the problem.

When you contact Technical Support, please have the following information
available:

■ Product release level

www.symantec.com/business/support/
www.symantec.com/business/support/


■ Hardware information

■ Available memory, disk space, and NIC information

■ Operating system

■ Version and patch level

■ Network topology

■ Router, gateway, and IP address information

■ Problem description:

■ Error messages and log files

■ Troubleshooting that was performed before contacting Symantec

■ Recent software configuration changes and network changes

Licensing and registration
If your Symantec product requires registration or a license key, access our technical
support Web page at the following URL:

www.symantec.com/business/support/

Customer service
Customer service information is available at the following URL:

www.symantec.com/business/support/

Customer Service is available to assist with non-technical questions, such as the
following types of issues:

■ Questions regarding product licensing or serialization

■ Product registration updates, such as address or name changes

■ General product information (features, language availability, local dealers)

■ Latest information about product updates and upgrades

■ Information about upgrade assurance and support contracts

■ Information about the Symantec Buying Programs

■ Advice about Symantec's technical support options

■ Nontechnical presales questions

■ Issues that are related to CD-ROMs, DVDs, or manuals
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Support agreement resources
If you want to contact Symantec regarding an existing support agreement, please
contact the support agreement administration team for your region as follows:

customercare_apac@symantec.comAsia-Pacific and Japan

semea@symantec.comEurope, Middle-East, and Africa

supportsolutions@symantec.comNorth America and Latin America

mailto:customercare_apac@symantec.com
mailto:semea@symantec.com
mailto:supportsolutions@symantec.com
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Preparing for installation

This chapter includes the following topics:

■ About changes in NetBackup 7.5

■ About changes in NetBackup 7.1

■ About changes in NetBackup 7.0

■ About NetBackup mixed version support

■ About Symantec Operations Readiness Tools

■ About NetBackup 7.5 availability

■ Requirements for Windows NetBackup server installation

■ Requirements for upgrading Windows servers to NetBackup 7.5

■ About the NetBackup preinstallation Environment Checker

■ About storage device configuration

■ About replacing NetBackup server types not supported in NetBackup 7.x

About changes in NetBackup 7.5
The following describes some important changes to NetBackup version 7.5. For
complete details, see the NetBackup Release Notes for version 7.5.
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Note: If you currently use NetBackup 6.x and plan to upgrade to version 7.5, be
aware that NetBackup versions 7.0 and 7.1 contained many changes and
enhancements. Before you upgrade from any 6.x version to 7.5, refer also to the
NetBackup Release Notes for versions 7.0 and 7.1 for complete details. You can
also refer to the following topics for a summary of changes in NetBackup versions
7.0 and 7.1: See “About changes in NetBackup 7.0” on page 23.See “ About changes
in NetBackup 7.1” on page 21.

Table 1-1 Changes in NetBackup 7.5

DescriptionChange

Starting with NetBackup 7.5, all backup image metadata is
stored in the relational database (NBDB). Previous versions
stored this data in both the NBDB and flat ASCII files (image
header files).

The following describes the advantages of this change:

■ Eliminates the consistency issues for any data that
previously existed in multiple databases.

■ Improves the product search performance, especially in
large catalogs.

■ Improves the performance of restores, policy scheduling,
and image cleanups.

After an upgrade from a previous version of NetBackup,
post-upgrade migration of pre-existing image metadata
from the file system to the NetBackup database occurs.

Caution: This enhancement affects upgrades. To help
ensure a successful upgrade to NetBackup 7.5, please visit
the NetBackup 7.5 Upgrade Portal for complete upgrade
details: http://www.symantec.com/docs/TECH74584

For full details about the image migration process and help
to plan for this migration, refer to the following:

See “About image metadata migration after upgrades to
NetBackup 7.5” on page 15.

See “Planning for image metadata migration after an
upgrade to NetBackup 7.5” on page 19.

Enhanced NetBackup image
metadata management

Preparing for installation
About changes in NetBackup 7.5
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Table 1-1 Changes in NetBackup 7.5 (continued)

DescriptionChange

The following describes the UNIX platform changes:

■ Linux zSeries SUSE 64-bit

This platform now uses SLES 10, patch 2. NetBackup 7.5
cannot be installed on these systems if the OS kernel is
older than 2.6.16.

■ Linux RedHat x86_64 and Linux zSeries RedHat 64-bit

These platforms now use RH 5, update 4. NetBackup 7.5
cannot be installed on these systems if the OS kernel is
older than 2.6.18.

■ Solaris x64

Starting with NetBackup 7.5, this platform supports
Informix 11.

■ Macintosh OS X

This platform now uses version 10.6. NetBackup 7.5
cannot be installed on these client systems if the OS
version is older than 10.6.

UNIX platforms

NetBackup 7.5 completes the native packaging
implementation for servers on the HP-UX, RHEL, SLES, and
AIX platforms as follows:

■ The installation script installs the package by using the
appropriate OS installation command for that server
platform.

■ After the installation has completed, use the appropriate
native package management system query command to
see the list of NetBackup server packages.

■ Removing NetBackup 7.5 and later server software
requires the use of the specific OS package removal
command.

UNIX server packages

This platform is no longer supported for use as a client.Novell NetWare

Server and client support are discontinued for this platform
in NetBackup 7.5.

NetBackup 7.5 provides back-level support only for Windows
IA64 clients.

Windows IA64

13Preparing for installation
About changes in NetBackup 7.5



Table 1-1 Changes in NetBackup 7.5 (continued)

DescriptionChange

Starting with NetBackup 7.5, the NetBackup Product
Improvement Program captures installation deployment
and product usage information.

During the installation, you can choose to participate in the
NetBackup Product Improvement Program and send this
information automatically and in a secured manner to
Symantec. The information received becomes part of a
continuous quality improvement program that helps
Symantec understand how customers configure, deploy,
and use the NetBackup product. This information is then
used to help Symantec identify improvements in product
features, testing, technical support, and future
requirements.

To learn more about the NetBackup Product Improvement
Program, refer to the NetBackup license agreement section
17.19 Privacy; Data Protection. The following describes
where to find the license agreement:

■ UNIX

See the file LICENSE in the base directory of the UNIX
images on the DVD media or from the downloaded media
images from FileConnect.

■ Windows

From the DVD media or the downloaded media images
from FileConnect, start the installation wizard
(Browser.exe). On the Home page, click Installation.
On the Installation page, select either Server Software
Installation or Client Software Installation. On the
Welcome page, click Next to advance to the License
Agmt page.

NetBackup Product
Improvement Program

■ ssh command

Starting with NetBackup 7.5, UNIX clusters can run the
ssh command. The root user guidelines for the ssh
command are the same as those for the rsh command.

■ Cluster node upgrade order

Starting with NetBackup 7.5, you can select whether to
first upgrade the inactive node or the active nodes.

UNIX clusters

Preparing for installation
About changes in NetBackup 7.5
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About image metadata migration after upgrades to NetBackup 7.5
The following information describes important details about the image metadata
migration processes that occur after you upgrade to NetBackup 7.5.

After an upgrade from a previous NetBackup version, post-upgrade migration of
all pre-existing image metadata from the file system to the NetBackup database
occurs.

Please note the following in regard to this migration:

■ The LIST_FS_IMAGE_HEADERS entry is created automatically when the
post-upgrade image metadata migration has completed.

Warning:Do not manually create theLIST_FS_IMAGE_HEADERS entry. Premature
creation of this entry causes non-migrated images to be unrecognized during
NetBackup processing. This problem can result in possible data loss. For a
complete explanation about this entry, see the NetBackup Administrator's
Guide, Volume I.

■ Image metadata consistency checking that is comparable to the bpdbm

-consistency 2 -move command is performed as part of the image metadata
migration.
For more information about consistency checking details and the bpdbm

command, see the NetBackup Commands Reference Guide.

■ Until migration is complete, NetBackup behavior is affected.
See “Planning for image metadata migration after an upgrade to NetBackup
7.5” on page 19.

A number of methods are available to accomplish the migration. Before you
upgrade, review the following information to determine the most appropriate
method to help reduce the effect on normal NetBackup operations:

Review the methods for image metadata migration.In Table 1-2:

Review the NetBackup 7.5 Upgrade Guide.

This guide describes the estimated migration times based
on the migration method and the number of images to be
migrated.

Click on the following link to go to the portal:

http://www.symantec.com/docs/TECH74584

On the NetBackup 7.5
Upgrade Portal:

See “Planning for image metadata migration after an
upgrade to NetBackup 7.5” on page 19.

In theNetBackup Installation
Guide for 7.5:

15Preparing for installation
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Table 1-2 Image metadata migration methods for upgrades to NetBackup 7.5

DescriptionMethod

This method is useful in a backup environment that has the
following:

Acceptable CPU performance and a catalog image count
where NetBackup operations are acceptable during each
step of the serial image migration.

Use this method for environments with or without capacity
managed disk policies, such as SLP or DSSU.

The following describes how this method works:

■ An image is migrated after a NetBackup process updates
the image.

■ At the first instance of the nbstserv process, images
to be deleted, DSSU images, and images associated with
storage lifecycle policy (SLP) jobs are migrated. Auto
Image Replication images are also included.

Note: For more information about nbstserv, see the
NetBackup Administrator's Guide, Volume I.

■ As part of catalog cleanup, any images that are
associated with Advance Disk policies, BasicDisk policies,
and tape policies are migrated.

Typical migration method
(default)

Preparing for installation
About changes in NetBackup 7.5
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Table 1-2 Image metadata migration methods for upgrades to NetBackup 7.5
(continued)

DescriptionMethod

This method is useful in a backup environment that has the
following:

Acceptable CPU performance and a catalog image count
where NetBackup operations are acceptable during each
step of the serial image migration.

Use this method if you require AdvancedDisk reporting
immediately after the nbstserv portion of the migration.

The following describes how this method works:

■ Before the upgrade, create the following touch-file:

./netbackup/bin/MERGE_ALL_IMAGE_HEADERS

■ An image is migrated after a NetBackup process updates
the image.

■ At the first instance of the nbstserv process, images
to be deleted, DSSU images, and storage lifecycle policy
(SLP) jobs are migrated. Auto Image Replication images
and any images that are associated with Advance Disk
policies are also included.

■ As part of catalog cleanup, any images that are
associated with BasicDisk policies and tape policies are
migrated.

AdvancedDisk priority
method

17Preparing for installation
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Table 1-2 Image metadata migration methods for upgrades to NetBackup 7.5
(continued)

DescriptionMethod

This method uses the cat_import command and is useful
in a backup environment that has the following:

Acceptable CPU performance, but a catalog image count
that is high enough that you want to reduce the impact on
NetBackup operations during the image metadata migration.

After the nbstserv image migration has completed, and
before the normal catalog cleanup is scheduled to begin,
multiple instances of this command can be run in parallel
to migrate images on a client by client basis. For more details
about the cat_import command, see the NetBackup
Commands Reference Guide.

Before you execute this command, plan your usage as
follows:

■ Determine client priority.

■ Analyze system performance characteristics to
determine the desired number of cat_import
commands to run in parallel.

■ Run concurrent cat_import processes by client
priority.

■ Monitor the migration rate of eachcat_importprocess
to determine performance characteristics.

Large catalog image count
method

While the image metadata migration is in progress, certain NetBackup operations
cannot run while images are merged into their new locations.

The following describes the affected NetBackup operations that cannot run until
after the migration has completed:

■ Fragment deletion of expired disk images does not occur.

■ Capacity managed disk policies such as a storage lifecycle policy (SLP) or a
disk staging storage unit (DSSU) are not likely to start. If they do start, they
may encounter issues with insufficient available space in the disk volume.

■ SLP operations cannot run.

■ Automated Image Replication operations cannot run.

■ Until either the catalog cleanup job or the cat_import image metadata
migration has completed, NetBackup must search for images in both the flat
file system and the NBDB repositories. Therefore, the performance of
NetBackup image catalog queries is affected.
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To help you prepare and plan for a successful upgrade, refer to the following topic:

See “Planning for image metadata migration after an upgrade to NetBackup 7.5”
on page 19.

Planning for image metadata migration after an upgrade to NetBackup
7.5

Because each NetBackup environment configuration is unique, post-upgrade
migration performance varies. Factors include but are not limited to environments
with multiple platforms, complex configurations, or very large catalogs.

To help you gauge the amount of time for the migration process to complete, see
the NetBackup 7.5 Upgrade Guide located on the NetBackup 7.5 Upgrade Portal.
Click on the following link to go to the portal:

http://www.symantec.com/docs/TECH74584

To help you prepare for a successful upgrade to NetBackup 7.5, Symantec
recommends that you review the information in the following procedures. Make
any necessary additions to your upgrade plans that apply to your specific backup
environment.

To prepare for monitoring the image metadata migration that occurs after the
upgrade

1 For upgrades from NetBackup 6.5 or later, run the following command to
determine the number of storage lifecycle policy (SLP) image-related records:

■ On UNIX systems:
nbstlutil list -l | grep " I " | wc -l

■ On Windows systems:
nbstlutil list -l | %SystemDrive%\Windows\System32\find.exe

/C " I "

2 Run the following command to determine the number of images in the flat
file system:

Note: Because each NetBackup environment configuration is unique, the
execution time of this command varies. Factors include but are not limited
to environments with multiple platforms, complex configurations, or very
large catalogs.

■ On UNIX systems:
bpimagelist -idonly -d 01/01/1970 00:00:00 | wc -l
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■ On Windows systems:
bpimagelist -idonly -d 01/01/1970 00:00:00 |

%SystemDrive%\Windows\System32\find.exe /C " ID: "

3 Determine the method that you plan to use to accomplish the image metadata
migration, as follows:

■ Review and familiarize yourself with the different methods available to
accomplish the image metadata migration.
See “About image metadata migration after upgrades to NetBackup 7.5”
on page 15.

■ Review the image metadata migration performance data that is related
to the different migration methods.
See the NetBackup 7.5 Upgrade Guide on the NetBackup 7.5 Upgrade
Portal.
http://www.symantec.com/docs/TECH74584

■ With the information from the previous bulleted items, determine the
appropriate method that you plan to use. Document the method steps in
your upgrade plan.

4 For NetBackup configurations that use capacity managed disk storage units
such as an SLP or a disk staging storage unit (DSSU):

Plan to expire additional images from capacity managed disk volumes. For
complete details, see theNetBackup 7.5UpgradeGuide on the NetBackup 7.5
Upgrade Portal:

http://www.symantec.com/docs/TECH74584

5 For backup environments that use disk-based storage units, do the following:

As close to starting the upgrade as possible, run the following command to
delete expired disk image fragments:

nbdelete -allvolumes

After you have completed the previous steps, you are ready to upgrade to
NetBackup 7.5. The upgrade procedure is included in theNetBackup7.5 Installation
Guide.

After you have completed the upgrade procedure, you are ready to perform the
post-upgrade tasks as necessary for the migration method that you selected.

To perform the necessary post-upgrade tasks

1 Monitor the progress of the specific processes in the image metadata migration
method you have selected, as follows:

■ For nbstserv, run the following command:
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■ On UNIX systems:
nbstlutil list -l | grep " I " | wc -l

■ On Windows systems:
nbstlutil list -l | %SystemDrive%\Windows\System32\find.exe

/C " I "

Note: For more information about nbstserv, see the NetBackup
Administrator's Guide, Volume I.

■ For the catalog cleanup job, use the Activity Monitor progress log.
In the Jobs tab pane, double-click on the specific image cleanup job. When
the Job Details dialog box appears, click on the Detailed Status tab.

■ For each cat_import process, review the progress indications in STDOUT.

2 Be aware of the expected NetBackup behavior during the image metadata
migration, as follows:

■ While nbstserv is migrating image metadata information:

Fragment deletion of expired disk images does not occur (see step 5 in the
previous procedure).

■ Capacity managed disk policies such as SLP or DSSU are not likely to start.
If they do start, they may encounter issues with insufficient available
space in the disk volume.

■ SLP operations cannot run until after the migration has completed.

■ Automated Image Replication operations cannot run until after the
migration has completed.

■ Until either the catalog cleanup job or the cat_import image metadata
migration has completed, NetBackup must search for images in both the
flat file system and the NBDB repositories. Therefore, the performance
of NetBackup image catalog queries is affected.

3 To get a backup of the new NetBackup databases after the migration has
completed, run a full hot catalog backup.

About changes in NetBackup 7.1
The following describes a summary of important changes in NetBackup 7.1.
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Note: If you currently use NetBackup 6.x and plan to upgrade to version 7.5, be
aware that versions 7.0 and 7.1 contained many changes and enhancements.
Before you upgrade from NetBackup 6.x to 7.5, see the NetBackup Release Notes
for versions 7.0. and 7.1 for complete details.

Starting with NetBackup 7.1, this option is installed with
the NetBackup server and the client packages (if the
platform supports the product). A separate installation or
upgrade procedure is no longer required. However, a valid
license is still required to enable the product and the option
must be configured to be used.

The components have been renamed to NetBackup Product
Authentication and Authorization.

NetBackup Access Control

■ Native packaging for NetBackup clients

NetBackup 7.1 delivers the following NetBackup clients
in their native package formats:

AIX, HP-UX, Linux, and Solaris.

Installation on these systems is unchanged, therefore
the packages are not standalone. However, removal of
NetBackup from these systems now requires the use of
native commands.

All other UNIX client packages are delivered in the same
format as previous versions.

UNIX systems

■ New preinstallation Environment Checker feature

This feature lets you check those computers where you
plan to install or upgrade to NetBackup 7.1 or later. After
you run the Environment Checker, a summary of the
results identifies any potential issues that may prevent
a successful installation or upgrade. Also, a log is
generated that describes the complete results and
identifies which areas to address before you install or
upgrade to NetBackup 7.1 or later.

See “About the NetBackup preinstallation Environment
Checker” on page 35.

■ Improved integrated cluster installation and upgrade
process

The process to install and upgrade cluster installations
has been improved to provide feedback to customers,
and to validate cluster environments before
configuration takes place.

See “Installing or upgrading servers in clustered
environments” on page 85.

Windows systems
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About changes in NetBackup 7.0
The following describes a summary of important changes in NetBackup 7.0.

Note: If you currently use NetBackup 6.x and plan to upgrade to version 7.5, be
aware that versions 7.0 and 7.1 contained many changes and enhancements.
Before you upgrade from NetBackup 6.x to 7.5, see the NetBackup Release Notes
for versions 7.0. and 7.1 for complete details.

This product has reached its end of life and is no longer
supported.

Veritas Storage Migrator
(VSM)

Starting with NetBackup 7.0, NOM has been replaced with
OpsCenter.

If your current 6.x NetBackup environment includes NOM
6.x, you can upgrade NOM to OpsCenter with an upgrade to
NetBackup 7.0 or later.

NetBackup Operations
Manager (NOM)
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Starting with NetBackup 7.0, the following platform support
changes apply:

■ Except for FreeBSD clients and Mac clients, all UNIX
32-bit system support has been discontinued.

To upgrade these systems to NetBackup 7.0 or later, you
must first migrate your current NetBackup 6.x catalogs
and databases to a system with a supported 64-bit
platform.

However, 32-bit media servers and the clients that use
NetBackup 6.x are compatible with NetBackup 7.x 64-bit
master servers.

Also, NetBackup requires OpenStorage vendor plug-ins
to be 64-bit. When you upgrade a media server that is
used for OpenStorage to NetBackup 7.x, you also must
update the vendor plug-in to a 64-bit version.

For details about how to replace the servers that
currently use these unsupported platforms, refer to the
following section:

See “About replacing NetBackup server types not
supported in NetBackup 7.x” on page 43.

■ IRIX and Tru64 are no longer supported.

Servers and clients with these operating systems that
use NetBackup 6.x are compatible with NetBackup 7.x
servers.

■ All 64-bit platforms are supported except for FreeBSD
clients and Mac clients.

■ Windows IA64 is supported only as a client.

■ Linux SUSE and Linux RedHat Itanium are no longer
supported for use as master or media servers. These
platforms are only supported as a client.

■ HP-UX PA-RISC is no longer supported as a master
server. This platform is supported only as a true media
server (media server without the EMM server) or a true
client.

■ Novell NetWare is no longer supported for use as a media
server. This platform is only supported as a client.

Platform and operating
system support changes
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Starting with NetBackup 7.0, most of the add-on products
and database agents are now installed with the NetBackup
server or the client package. Separate installation for these
products is no longer needed.

The following products are now included in the NetBackup
server package (if the platform supports the product):

■ BMR master server

■ NDMP

■ Vault

The following products are now included in the NetBackup
client package (if the platform supports the product):

■ BMR Boot server

■ DB2

■ Encryption

■ Informix

■ LiveUpdate agent

■ Lotus Notes

■ Oracle

■ SAP

■ Snapshot Client

■ Sybase

The binaries for the listed products are laid down with the
server or the client package. A valid license is still required
to enable the product. If product configuration was required
previously (such as db2_config), configuration is still
required.

Note: For Solaris server upgrades, the older versions of any
listed products here must be removed before an upgrade to
NetBackup 7.0 or later. For example, VRTSnbdb2,
SYMCnbdb2, VRTSnbenc, SYMCnbenc, and others. The
installation script displays a list of the packages it finds that
must be removed.

The French, Japanese, and the Chinese language packages
remain as separate add-ons. The process to install and
upgrade these products remains the same.

UNIX package consolidation

New NetBackup 7.0 or later media server installations
cannot be clustered. However, existing 6.x clustered media
servers can be upgraded to version 7.0 or later and remain
clustered.

Clustered media server
support changes
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About NetBackup mixed version support
You can run mixed versions of NetBackup between master servers, media servers,
and clients. This back-level support lets you upgrade NetBackup one server at a
time, which minimizes the effect on overall system performance. Symantec
supports only certain combinations of servers and clients.

Table 1-3 lists the supported mixed version configurations for NetBackup 7.5.

Table 1-3 Supported NetBackup mixed version configurations

Client versionMedia server
version

Master server
version

Configuration

7.5

(For catalog backups,
see the note
immediately after
this table.)

7.57.51

6.0.x, 6.5.x, or 7.x

(For catalog backups,
see the note
immediately after
this table.)

7.57.52

6.0.x, 6.5.x, or 7.x

Clients in this
configuration must
use a version that is
equal to or earlier
than media server
versions.

(For catalog backups,
see the note
immediately after
this table.)

6.0.x, 6.5.x, or 7.x7.53

Note: The NetBackup catalog resides on the master server. Therefore, the master
server is considered to be the client for a catalog backup. If your NetBackup
configuration includes a media server, it must use the same NetBackup version
as the master server to perform a catalog backup.
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NetBackup versions 7.0 and later do not support Windows 2000 systems. However,
you can still use NetBackup version 6.x on Windows 2000 clients with your
NetBackup 7.x servers.

The following describes what type of action to take if you have any clients that
run Windows 2000:

No action is required. These clients are compatible
with NetBackup version 7.x master and media
servers.

To ensure future compatibility, it is recommended
that you replace these clients with those that use
a more current operating system.

Existing NetBackup customers with
Windows 2000 clients at NetBackup
version 6.x:

You must install NetBackup version 6.x client
software on your Windows 2000 systems.

To obtain NetBackup version 6.x, contact your
Symantec NetBackup representative or call
technical support.

New NetBackup customers with
Windows 2000 systems:

For complete information on mixed version support, see the NetBackup Release
Notes for version 7.5. Refer to the section "NetBackup backward compatibility".

About Symantec Operations Readiness Tools
Symantec Operations Readiness Tools (SORT) is a set of Web-based tools that
supports Symantec enterprise products. For NetBackup, SORT provides the ability
to collect, analyze, and report on host configurations across UNIX/Linux or
Windows environments. This data helps to assess whether your systems are ready
for an initial NetBackup installation or for an upgrade from your current version.

To access SORT, go to the following Web page:

http://sort.symantec.com/netbackup

Once you get to the SORT page, more information is available as follows:

■ Installation and Upgrade Checklist
Use this tool to create a checklist to see if your system is ready for a NetBackup
installation or an upgrade.

■ Hot fix and EEB Release Auditor
Use this tool to find out whether a release that you plan to install contains the
hot fixes that you need.

■ Custom Reports
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Use this tool to get recommendations for your system and Symantec enterprise
products, tips for risk assessment, and product license tracking.

About NetBackup 7.5 availability
NetBackup 7.5 is available in the following formats:

■ DVD media kit
All necessary software and documentation files are provided on several DVDs.
See “About the NetBackup media kit” on page 28.

■ Electronic Software Distribution (ESD) images
The DVD image files are posted and available for download on the FileConnect
Website.
See “About the NetBackup Electronic Software Distribution (ESD) images”
on page 30.

About the NetBackup media kit
The media kit includes a DVD for each supported UNIX platform or operating
system and one DVD for Windows. The label on each DVD provides a brief
description of its contents.

NetBackup documentation is also included. All documentation for the NetBackup
software products in this release is included.

Printed materials include a Getting Started Guide. Documentation on the DVDs
is in Portable Document Format (PDF). You can use Acrobat Reader to open, view,
and print the files.

If Autorun is enabled on your Windows system, you see a Web page that lists the
documents that you can select to view. On UNIX or Linux systems, or if Autorun
is disabled on the Windows system, navigate to the DVD drive to view the DVD
contents. From that drive, you can select the documents to view or copy them to
a local drive.

The following table describes the contents of each DVD.

Table 1-4 NetBackup 7.5 DVD contents

ContentsPlatform OSDVD No.

■ Server and supported options

■ NetBackup documentation

AIX 64-bit1
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Table 1-4 NetBackup 7.5 DVD contents (continued)

ContentsPlatform OSDVD No.

■ Server and supported options

■ NetBackup documentation

HP-UX IA642

■ Media server and supported
options

■ NetBackup documentation

HP-UX PA-RISC 64-bit3

■ Server and supported options

■ NetBackup documentation

Linux RedHat x86_644

■ Server and supported options

■ NetBackup documentation

Linux SUSE x86_645

■ Server and supported options

■ NetBackup documentation

Solaris SPARC646

■ Server and supported options

■ NetBackup documentation

Solaris x86-647

■ Server and supported options

■ All x86 and x64 clients

■ NetBackup documentation

Windows x86 and x648

■ Media server and supported
options

■ NetBackup documentation

Linux zSeries RedHat x649

■ Media server and supported
options

■ NetBackup documentation

Linux zSeries SUSE x6410

■ All UNIX clients

■ NetBackup documentation

UNIX clients11

■ All UNIX and Windows clients in
LiveUpdate format

■ Readme document

Clients in LiveUpdate format12

■ All Windows platforms

■ ICS (NBAC)

OpsCenter (1 of 3)13
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Table 1-4 NetBackup 7.5 DVD contents (continued)

ContentsPlatform OSDVD No.

■ RedHat

■ SUSE

■ Solaris x86

■ ICS (NBAC)

OpsCenter (2 of 3)14

■ AIX

■ HP-UX IA64

■ Solaris SPARC

■ ICS (NBAC)

OpsCenter (3 of 3)15

NetBackup Client for OpenVMSOpenVMS (CD format)16

See “About the NetBackup Electronic Software Distribution (ESD) images”
on page 30.

About the NetBackup Electronic Software Distribution (ESD) images
The ESD images for NetBackup 7.5 are available for download from the FileConnect
Web page. The images adhere to a 1.8G size limitation.

To ensure the accuracy of the ESD download, some of the product images have
been split into smaller, more manageable files. Before you uncompress any file,
you must first join the split image files that you can identify as 1 of 2 and 2 of

2. A Download Readme.txt file on FileConnect describes how to join the files
together.

See “About NetBackup 7.5 availability” on page 28.

See “About the NetBackup media kit” on page 28.

See “Requirements for Windows NetBackup server installation” on page 30.

Requirements for Windows NetBackup server
installation

Before you install NetBackup, make sure that your backup environment meets
the following requirements:
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Remove any other vendor’s backup software currently
configured on your system. The backup software of another
vendor can negatively affect how NetBackup installs and
functions.

Other backup software

Before you install your NetBackup product, make sure that
you have applied the most current operating system patches
and updates. If you are not certain that your operating
system is current, contact your operating system vendor
and request the latest patches and upgrades.

OS updates

Devices such as robots and stand-alone tape drives must be
installed according to the manufacturers’ instructions and
recognized by the Windows software.

Storage devices

Make sure that your network configuration allows all servers
and clients to recognize and communicate with one another.

Generally, if you can reach the clients from a server by using
the ping command, the setup works with NetBackup.

Backup environment
communication

The server system configuration should comply as follows:

■ Operating system

Windows 2003 Server/XP, Windows 2008 Server/Vista,
or Windows 2008 R2 Server/Windows 7.

■ Memory

As a general rule, the minimum memory requirement
for master servers is 2GB RAM per processor.

For additional information about memory requirements,
refer to theNetBackupBackupPlanningandPerformance
Tuning Guide.

■ Screen resolution

Should be configured for at least 1024x768, 256 colors.

Server configuration
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■ An NTFS partition.

■ At least 1 GB of storage space to accommodate the server
software (512 MB) and NetBackup catalogs (at least 512
MB).

NetBackup catalogs contain information about your
backups, which become larger as you use the product.
The catalog disk space requirements depend primarily
on the aspects of your backup configuration. For
example, the number of files that are backed up, the
frequency of your backups, and how long you retain your
backup data.

■ For upgrades, you must have an additional 500 MB of
disk space on the drive where Windows is installed. After
the upgrade is complete, this additional space is not
needed.

Disk space requirements

Make sure that you have all of the following items:

■ NetBackup installation DVDs or ESD images

■ Appropriate license keys

■ Administrator account and password for all servers

Note: To install NetBackup on Windows 2008/Vista and
Windows 2008 R2/Windows 7 UAC-enabled environments,
you must log on as the official administrator. Users that are
assigned to the Administrators Group and are not the official
administrator cannot install NetBackup in UAC-enabled
environments. To allow users in the Administrators Group
to install NetBackup, disable UAC.

General requirements

When you are prompted for server names, always enter the
appropriate host names. Do not enter IP addresses.

Server names

Make sure to install NetBackup servers with a release level
that is at least equal to the latest client version that you
plan to use. Earlier versions of server software can
encounter problems with later versions of client software.

Mixed versions

Symantec does not support installation of NetBackup in a
CIFS-mounted directory. File locking in CIFS-mounted file
systems can be unreliable.

CIFS-mounted file systems

NetBackup can be installed on these systems only by using
the silent installation method.

See “Installing or upgrading NetBackup servers silently”
on page 104.

Installations on Windows
2008 Server Core
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NetBackup services and port numbers must be the same
across the network.

Symantec suggests that you use the default port settings
for NetBackup services and Internet service ports. If you
modify the port numbers, they must be the same for all
master servers, media servers, and clients. The port entries
are in the following file:

%SYSTEMROOT%\system32\drivers\etc\services

To change the default settings, you must perform a
NetBackup custom installation of NetBackup or edit the
services file manually.

NetBackup communication

You must provide the names of Remote Administration
Console hosts during master server installation.

Remote Administration
Console installation

In addition to all previously stated installation requirements,
the following guidelines apply to remote installations and
cluster installations:

■ The source system (or primary node) must run Windows
2003/2008/2008 R2 Server.

■ The destination PC (or clustered nodes) must have
Windows 2003/2008/2008 R2 Server.

■ The installation account must have administrator
privileges on all the remote systems or on all nodes in
the cluster.

■ All nodes in a cluster must run the same operating
system, service pack level, and version of NetBackup.
You cannot mix versions of server operating systems.

Remote and cluster
installations

Requirements for upgrading Windows servers to
NetBackup 7.5

Before you upgrade, refer to the NetBackup Release Notes for version 7.5 for
complete details about the changes that may affect how to upgrade your NetBackup
environment.

Warning: To help ensure a successful upgrade to NetBackup 7.5, please proceed
immediately to the following NetBackup 7.5 Upgrade Portal for complete upgrade
details: http://www.symantec.com/docs/TECH74584
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Note: If you currently use NetBackup 6.x and plan to upgrade to version 7.5, be
aware that NetBackup versions 7.0 and 7.1 contained many changes and
enhancements. Before you upgrade from any 6.x version to 7.5, you should refer
to theNetBackup Release Notes for versions 7.0 and 7.1 for complete details. You
can also refer to the following topics for a summary of changes in NetBackup 7.0
and 7.1: See “ About changes in NetBackup 7.1” on page 21. and See “About changes
in NetBackup 7.0” on page 23.

The following describes the general requirements for Windows server upgrades:

■ Direct upgrades to NetBackup 7.5

You can upgrade directly to NetBackup 7.5 from versions
6.x, 7.0, or 7.1.

This installation guide includes the procedures for these
upgrades.

■ Upgrades from 5.x versions

If you currently use NetBackup 5.x versions, you cannot
upgrade directly to 7.5. You must first upgrade to
NetBackup 6.0 or 6.5. Symantec recommends that you
upgrade to 6.5.

An upgrade guide is posted on the upgrade portal at the
following location:

http://www.symantec.com/docs/TECH52785.

After you upgrade to 6.5, you can upgrade to 7.5.

Supported upgrade paths

Before you proceed with any upgrade procedure, always
back up your existing NetBackup database. If an error occurs
during the upgrade, you can restore the previous version
and still retain your information from the database backup.

Back up databases

Many of the NetBackup server installation requirements
also apply to NetBackup upgrades. Review these
requirements before you upgrade.

See “Requirements for Windows NetBackup server
installation” on page 30.

Review installation
requirements

NetBackup can be upgraded on these systems only by using
the silent installation method.

See “Installing or upgrading NetBackup servers silently”
on page 104.

Upgrades on Windows 2008
Server Core

When you perform an upgrade, a master server cannot be
changed to a media server. To make this change, you must
first uninstall the earlier version of NetBackup, then perform
an installation of the new version.

Converting master servers to
be media servers
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For NetBackup Enterprise upgrades, you cannot convert an
existing non-failover server to a highly available NetBackup
failover (clustered) server.

Converting non-failover
servers to be NetBackup
failover (clustered) servers

Make sure that the NetBackup version on each server is at
least equal to the version on any clients. Earlier software
versions on servers can encounter problems with later
software versions on clients.

See “About NetBackup mixed version support” on page 26.

Version support between
servers and clients

Add-ons must be at the same version as the NetBackup
server or the client where the add-on is installed.

Add-on product versions

Starting with NetBackup 7.1, NetBackup Access Control
(NBAC) is installed with NetBackup. If you currently use
NBAC in NetBackup versions 6.x through 7.0.1, a separate
upgrade is no longer required. An upgrade to version 7.1 or
later automatically migrates all NBAC files from a shared
location to a location within NetBackup.

If you currently use NBAC with products other than
NetBackup, the existing NBAC files are located in a shared
directory. These files are not upgraded when you upgrade
to NetBackup 7.1 or later so that you can continue to use
NBAC with those products.

NetBackup Access Control
(NBAC)

If you have NetBackup clients that are unsupported for
NetBackup 7.x, you may encounter problems with new
features in this release. If you do not plan to upgrade these
earlier version clients, move them to a separate policy.

Conflicts with older clients
and new features

The NetBackup Administration Console must be closed when
you upgrade NetBackup. Otherwise, NetBackup may cause
a failure that forces you to restart the procedure.

NetBackup Administration
Console

About the NetBackup preinstallation Environment
Checker

Starting with NetBackup 7.1, an Environment Checker is included to help identify
any problems that may prevent a successful NetBackup server installation or
upgrade.

The Environment Checker is available as a link on the DVD browser and is a
standalone function that you run before an installation or an upgrade.

The Environment Checker provides you with the following abilities:
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■ Assess a system to determine if it is ready for a new NetBackup installation
or upgrade.

■ Perform the assessment on local and remote Windows systems.

■ Create a list of remote computers to check, either manually or by browsing
the network.

■ Run the Environment Checker on all supported Windows platforms that support
NetBackup as a master server or a media server (x86 and x64).

■ Generate HTML reports for immediate viewing.

See “ Running the preinstallation Environment Checker” on page 36.

Running the preinstallation Environment Checker
Use the following procedure to run the Environment Checker and assess whether
computers are ready for NetBackup installation.

To run the Environment Checker

1 Start the NetBackup Installation Wizard with one of the following methods:

■ DVD media
Insert the NetBackup for Windows DVD in the drive. If Autorun is disabled,
navigate to the DVD drive and run Browser.exe.

■ ESD images (downloaded files)
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Navigate to the directory where the images reside and run Browser.exe.

2 On the Home screen, click Preinstallation.
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3 On the Preinstallation screen, click Run the preinstallation Environment
Checker.
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4 On the Welcome screen, review the content and click Next.

5 On the Choose screen, select the systems to check as follows:

To check the local computer only, leave this option
checked and click Next.

After the computer check has completed, a summary
page appears that describes the results.

Local Environment Check
(default)
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■ To check one or more remote computers, select this
option and click Next.

Note: You can keep the LocalEnvironmentCheck
option to include the local computer. You can also
deselect this option to exclude it.

■ On the Remote screen, add or remove computers
to check as follows:

■ Add Server From List
Click this option to select a computer from a list
of available systems on your network. Then click
Next.

Enter the appropriateUserName and Password
for the selected computer, then click OK.

■ Add Server Manually
Click this option to add computer names
manually.

On the Manual Remote Computer Selection
dialog box, enter the appropriateDomainName
and the Server Name, then click OK.

On the Remote Computer Login Credentials
dialog box, enter the appropriate User Name
and Password, then click OK.

■ Remove
To remove a computer from the Remote
Computers list, select the computer from the
list and click Remove.

■ After all computers that you want to check are
added to the Remote Computers list, click Next.

The Environment Checker performs a validation
process for each remote computer. After all have
been completed, click Next to start the check on all
listed computers.

RemoteEnvironmentCheck
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6 When all computers have been checked, the Results screen displays a list of
the checked systems with a brief result under each computer name. Click on
a computer name to see the complete results for that computer. The following
describes the symbols that may appear in a summary:

Indicates that the item meets the requirements for a
NetBackup installation or an upgrade.

Green check mark

Indicates that a potential issue has been detected that
may, or may not cause a problem for a NetBackup
installation or an upgrade.

Yellow exclamation point

Indicates that the item does not meet the NetBackup
installation requirements. Any summary report items
with a red X must be corrected before you attempt a
NetBackup installation or an upgrade.

Red X

Note: Symantec recommends that you address all items that are marked with
a yellow exclamation point and a red X. Then run the Environment Checker
again.

7 To save the results file, do one of the following:

■ To save the results file to the default location, leave the check mark for
the Save Results To check box.

■ To save the results file to a different location, click Change Path, enter
the appropriate location, then click Save.

If you do not want to save the results file, click the Save Results To check
box to remove the check mark.

8 To exit from the Environment Checker, click Finish.

See “About the NetBackup preinstallation Environment Checker” on page 35.

About storage device configuration
Reliable use of NetBackup depends on the proper configuration of your storage
devices. To ensure reliable backups and restores, you must first install and
configure devices to work with the operating system.

Before you install or upgrade to NetBackup 7.1 or later, use the following guidelines
to configure storage devices to work with the operating system:
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Before you install or upgrade to NetBackup 7.1 or later,
Symantec recommends that you install and configure your
devices with the latest version of drivers.

New installations and
upgrades

To prepare and connect new devices, perform the following
tasks:

■ Set the SCSI ID (target). Make sure that it is set it to an
available SCSI ID.

■ Physically attach your device to a compatible host bus
adapter where that SCSI ID is available.

Compatible means that both the device and the host bus
adapter are of the same type. For example, single-ended,
high voltage differential, low voltage differential, or
Fibre Channel.

Connections and settings

To configure storage devices to work with the operating
system, refer to the following documentation:

■ The instructions from the device and the operating
system vendors.

■ The NetBackup Device Configuration Guide. See the
chapter that is appropriate for your operating system.

Configuration

After all storage devices are installed, configured, and
verified to work with the operating system, you can install
NetBackup.

NetBackup installation

Warning: An improperly configured device can lead to backup failures, data loss,
or both.

See “Requirements for Windows NetBackup server installation” on page 30.

Locating supported robot types
You can find a list of the supported robot types in the Symantec NetBackup
Server/Enterprise Server 7.x Hardware Compatibility List.

For your convenience, Symantec periodically updates this document on the
Symantec support Web site.

To find the latest robot types that this release supports

◆ Click on the following link to access theSymantecNetBackupServer/Enterprise
Server 7.x Hardware Compatibility List:

http://www.symantec.com/docs/TECH76495
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About replacing NetBackup server types not
supported in NetBackup 7.x

Certain hardware support and operating system support has been discontinued
in NetBackup 7.x. These systems must be replaced with supported systems before
an upgrade to NetBackup 7.x.

For complete details about hardware and operating system support in NetBackup
7.x versions, refer to the following documents:

■ NetBackup Release Notes for 7.5
http://www.symantec.com/docs/DOC5041
Refer to the sections "About platform and operating system support changes"
and "About NetBackup Compatibility Lists".

■ NetBackup Enterprise Server and Server 7.x OS Software Compatibility List
http://www.symantec.com/docs/TECH76648

■ NetBackup server 7.x hardware compatibility list
http://www.symantec.com/docs/TECH76495

The following describes the general guidelines to replace unsupported servers
before an upgrade to NetBackup 7.x:
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The platform and the architecture of the new system can
be different than the system that you replace, provided that
you observe the following rules:

■ An unsupported Windows server (hardware or operating
system) should be replaced with a supported Windows
server.

■ An unsupported UNIX or Linux server (hardware or
operating system) should be replaced with any other
supported UNIX or Linux server platform and operating
system. However, Red Hat Linux master servers are an
exception (see the following item).

■ An unsupported Red Hat Linux master server must be
replaced by another Red Hat Linux master server. The
version of Red Hat Linux and the server architecture
may be different.

For complete details on replacing NetBackup servers in
regard to platforms and operating systems, refer to the
following documents on the Symantec support Web site:

■ For Windows master servers:

http://www.symantec.com/docs/TECH77447

■ For UNIX master servers:

http://www.symantec.com/docs/TECH77448

■ For media servers:

http://www.symantec.com/docs/TECH77811

■ OpenStorage users should also refer to the following
document for details about specific considerations in
regard to upgrades to NetBackup 7.x:

http://www.symantec.com/docs/TECH77812

Platform and operating
system

The new supported system must use the exact same version
of NetBackup as the old system. You cannot migrate catalogs
and databases from one NetBackup version to a different
version.

For example, the old server uses NetBackup 6.5.2. You must
install this same version on the new server before you can
upgrade.

NetBackup version
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On the old system, you must create a hot catalog backup.
This backup is then used to restore the catalog to the new
supported system and complete the migration.

The method that you use to create the catalog backup can
make a difference in how you restore it on the new system.
For example:

■ Whether you back up the catalog to tape or disk

■ Whether you back up the catalog to a master server or
a media server

For complete details on how to create a hot catalog backup,
see the NetBackup Troubleshooting Guide.

Hot catalog backup

How to replace unsupported NetBackup master servers
The following steps describe only the primary tasks to replace an unsupported
master server.

For complete detailed instructions, refer to the following documents on the
Symantec support Web site:

http://www.symantec.com/docs/TECH77447

http://www.symantec.com/docs/TECH77448

OpenStorage users should also refer to the following document for details about
specific considerations in regard to upgrades to NetBackup 7.x:

http://www.symantec.com/docs/TECH77812

To replace an unsupported master server

1 Configure a new supported master server with the same name as the old
unsupported master server.

See “About replacing NetBackup server types not supported in NetBackup
7.x” on page 43.

2 Install the same version of NetBackup on the new master server that is used
on the old master server.

You must install NetBackup to the exact same path and location as the old
server.

3 On the old master server, create a hot catalog backup.

For complete details on how to create a hot catalog backup, see theNetBackup
Troubleshooting Guide.

4 Shut down the old master server and remove it from your backup
environment.
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5 Install the new master server in your backup environment.

6 Restore the catalog backup.

7 Run some test backups and restores to verify successful operation.

After you verify successful operation, you can upgrade to NetBackup 7.x.

How to replace unsupported NetBackup media servers
The following steps describe only the primary tasks to replace an unsupported
media server.

For complete detailed instructions, refer to the following document on the
Symantec support Web site:

http://www.symantec.com/docs/TECH77811

OpenStorage users should also refer to the following document for details about
specific considerations in regard to upgrades to NetBackup 7.x:

http://www.symantec.com/docs/TECH77812

To replace an unsupported media server

1 Deactivate the old media server through the NetBackup Administration
Console, or by running the following command:

nbemmcmd -updatehost -machinename <Media Server> -machinestateop

set_admin_pause -machinetype media -masterserver <Master Server>

2 Shut down the old media server.

3 Configure a new supported media server with the same name and IP address
as the old media server.

Note: To use a new IP address, make sure that you update the DNS.

4 Connect all backup storage devices to the new media server.

5 Install the same version of NetBackup on the new media server that is used
on the old media server. You must install NetBackup to the exact same path
and location as the old server.

Also, make sure that you specify the same list of additional servers that were
identified on the old server.

6 Install the new media server in your backup environment.
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7 Activate the new media server through the NetBackup Administration Console,
or by running the following command:

nbemmcmd -updatehost -machinename <Media Server> -machinestateop

clr_admin_pause -machinetype media -masterserver <Master Server>

8 Run the device discovery on the new media server so that all connected backup
storage devices are recognized.

9 Run some test backups and restores to verify successful operation.

After you verify successful operation, you can upgrade to NetBackup 7.x.
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NetBackup licenses

This chapter includes the following topics:

■ About NetBackup license key requirements

About NetBackup license key requirements
To install NetBackup master server or media server software, you must enter a
NetBackup product license key.

To obtain license keys, you must order a license SKU when you order your
NetBackup products.

After you place your order, Symantec sends you an email with a license certificate
that includes the following information:

This list includes all of the licenses for the products that
you ordered.

Keep this list in a secure location. You may be asked for a
product license key if you ever need to contact technical
support for assistance.

List of NetBackup licenses
purchased

Instead of a DVD media kit, you can use this serial number
to download the Electronic Software Distribution (ESD)
images for NetBackup product installation.

Go to the following Web site and enter this serial number
to download the ESD images to your system:

https://fileconnect.symantec.com/LangSelection.jsp

Serial number for access to
download NetBackup
products

When you install NetBackup, Symantec recommends that you enter all other
product license keys on the master server when you are prompted. Although you
can add these license keys later, it is easier to enter them when you install the
master server software.
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For detailed information on how to administer NetBackup license keys, refer to
the NetBackup Administration Guide, Volume I.

About NetBackup license compatibility
To use your current NetBackup license keys to upgrade servers, add-on products,
and database agents to NetBackup 7.5, the following are required:

■ NetBackup versions 6.x or 7.0.x must already be installed.

■ You must have a valid maintenance contract for all licensed NetBackup
products.

Note: You cannot upgrade to NetBackup 7.5 if your current installed version is
NetBackup 5.x. You must first upgrade to NetBackup 6.0 or 6.5, and then you can
upgrade to NetBackup 7.5. Any 6.x version can be upgraded directly to 7.5.

Upgrade licenses and software may be obtained from the Symantec Licensing
Portal at the following Web site:

https://licensing.symantec.com/acctmgmt/index.jsp

For detailed information and procedures on how to administer license keys, refer
to the NetBackup Administrator’s Guide, Volume I.

See “About license key entry” on page 50.

About license key entry
License keys for all NetBackup SKUs must be entered on the master server. License
keys for some SKUs must also be entered on the media server, depending on the
capabilities that you require for the media server.

Table 2-1 describes the license keys that must be entered on each server.
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Table 2-1 Required license keys for NetBackup media servers

Required licenses (based onmedia server capabilities)Media server type

■ NetBackup Enterprise Server 7.5 UNX

■ NetBackup Enterprise Server 7.5 WIN/LNX/SOLX64

■ NetBackup Standard Infrastructure 7.5 XPLAT1 Front
End TBYTE

■ NetBackup Enterprise Infrastructure 7.5 XPLAT1 Front
End TBYTE

■ NetBackup Platform Base

■ NetBackup Option Library Based Tape Drive 7.5 XPLAT

■ NetBackup Option Shared Storage Option 7.5 XPLAT

■ NetBackup Option NDMP 7.5 XPLAT

■ NetBackup Media Server Encryption Option for
Enterprise Server, UNIX

■ NetBackup Media Server Encryption Option for
Enterprise Server, Windows/Linux

Enterprise media servers

■ NetBackup Enterprise Client, UNIX

■ NetBackup Enterprise Client, Windows/Linux

■ Media Server Encryption Option for SAN Media Server
(Enterprise Client), UNIX

■ Media Server Encryption Option for SAN Media Server
(Enterprise Client), Windows/Linux

SAN media servers

Enter license keys by using one of the following methods:

■ During NetBackup master server and media server installation (recommended)
The installation script prompts you to enter the license keys for all NetBackup
products that you plan to install.

■ NetBackup Administration Console
After NetBackup master server or media server installation, open the console
and click Help > License Keys.

■ Command-line interface (UNIX only)
After NetBackup master server or media server installation, use the following
command:

/usr/openv/netbackup/bin/admincmd/get_license_key
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Note: You can log on to a NetBackup server from almost any server in a system
to view, enter, and administer license keys. When you administer license keys
remotely, make sure that you view the licenses of the system you intend to change.
You do not want to add or change a license key on the wrong server.

Frequently asked questions about license keys
Symantec customers have asked the following questions about how to manage
license keys.

NetBackup uses a common license system that other
Symantec products also use. Please remember, however,
that the common license system provides flexibility in the
license features that each product implements. For example,
NetBackup does not have a node-locked license system, but
some other products do.

Is the license system for
NetBackup the same as the
license system in other
Symantec products?

No. The media kit by itself does not allow any access to
NetBackup. You always need a license key (either permanent
or evaluation). License keys should always be delivered with
the media kit, so you should never find yourself with a media
kit and no key.

Can I use NetBackup if all I
have is a media kit?

The key is a multi-digit alphanumeric string (for example:
8EPP-ABCD-9XYZ-XYZ9-8881-VCF4-OIUF-AJDC). The key
contains information on the following:

■ Whether the key is for NetBackup Server or NetBackup
Enterprise Server

■ Whether the key is for a server, a client, an agent, or an
option (and which one)

■ Whether the key is a permanent key or an evaluation
key

■ Information about how and where the key was generated

What does the license key
look like? What information
does it contain?

Yes, serialization information is embedded in the key.Is the license key serialized?
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Yes. Information about license keys is stored on the master
server.

To access the information, open the NetBackup
Administration Console and select Help > License Keys.

On UNIX servers, you can also run the following command:

/usr/openv/netbackup/bin/admincmd/get_license_key

For more information on how to view reports, refer to the
NetBackup Administrator’s Guide, Volume I.

Can I see reports on what
license keys I have?

When you install NetBackup, you are prompted to enter the
license keys for all options and agents.

If you purchase an agent or other add-on product at a later
date, you can enter its license key manually. Open the
NetBackup Administration Console and select Help >
License Keys.

On UNIX servers, you can also run the following command:

/usr/openv/netbackup/bin/admincmd/get_license_key

Some options require that you have your original NetBackup
DVDs, because additional binaries must be installed. You
should always keep your NetBackup DVDs in a safe place.

How do I enable options and
agents?

Yes. Always store copies of your license keys in a secure
place.

Should I save license keys
after they have been entered?

Symantec has a record of all license keys that are issued to
customers. Customers who lose their license key(s) can call
Order Management to get copies of their license keys.

■ For Americas, Japan, PacRim, Australia:

650.318.4265 FAX: 650.335.8428

■ For Europe, Middle East and Africa:

00.353.61.365232 FAX: 00.353.61.365223

If you have purchased NetBackup from a Symantec partner,
you need to contact that partner for information on your
key.

What should I do if I have
lost my license key(s)?
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Many NetBackup installations are very large, and the license
keys are long. License keys that you enter multiple times
can be time-consuming. You can request a single license
key for each type of NetBackup component you purchase.
For example, you can obtain one license key for use with 50
Oracle agents. Site licenses enable unrestricted use for
specific NetBackup agents or options.

You still need a unique license key for each type of
NetBackup component that you purchase. Separate license
keys are required for components like NetBackup Server, a
Lotus Notes agent, or any NDMP option.

How are large volume orders
handled?

Site licenses are handled much like large volume orders are.
The certificate for a site license states that the license key
is good for unlimited copies.

What about license keys for
customers with site licenses?

No. NetBackup Remote Administration Consoles do not
require special license keys. You can install them on any
computer with access to the master server.

Do I need a license key to
enable NetBackup Remote
Administration Consoles?

Yes. You can use your license keys multiple times. You are,
however, legally bound to install and use only the number
of NetBackup servers, clients, agents, and options for which
you purchase licenses.

Can a license key be used
multiple times?

All NetBackup customers who have current maintenance
contracts with Symantec automatically receive the latest
version of NetBackup. You receive the NetBackup media kit
and license keys for every component for which you
purchased licenses.

If your maintenance is through a Symantec partner, you
upgrade through the partner. Contact the partner for more
details.

How do existing customers
get license keys?

If you believe that you received an incorrect license key,
contact Order Management using the number on your
license key certificate. Technical support does not issue
permanent license keys. You can obtain license keys only
through Order Management. Technical support can provide
temporary one-month license keys to you while issues
regarding permanent license keys are resolved.

What if I do not get the right
license keys?

The evaluation license key enables unrestricted use of
NetBackup, its agents, and its options for a predetermined
period of time.

What does an evaluation
license key enable?
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To find out when a license key expires, open the NetBackup
Administration Console and select Help > License Keys.

On UNIX servers, you can also run the following command:

/usr/openv/netbackup/bin/admincmd/get_license_key

Am I notified when an
evaluation is about to expire?

The NetBackup services or daemons are shut down. When
you attempt to use the product you are informed that its
evaluation period has expired.

What happens when an
evaluation license key
expires?

Yes. Customers who add a permanent license key to an
evaluation version of NetBackup have immediate access to
their catalog information and configuration information.

Does NetBackup save the
backup configuration and
catalog information when
evaluation license keys
expire?

It is easy. When you purchase a permanent license, you add
that license to NetBackup. All the configuration information
and catalog data from your evaluation version is retained.

To enter your permanent license key, open the NetBackup
Administration Console and select Help > License Keys.

On UNIX servers, you can also run the following command:

/usr/openv/netbackup/bin/admincmd/get_license_key

How do I upgrade from an
evaluation license to a
permanent license?
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Installing or upgrading
server software

This chapter includes the following topics:

■ How to install NetBackup

■ About the upgrade order for NetBackup 7.5

■ Installing or upgrading servers locally

■ Installing or upgrading servers remotely

■ Requirements for Windows cluster installations and upgrades

■ About automatic file changes from an upgrade

■ Installing or upgrading NetBackup servers silently

■ Upgrading NetBackup Servers to NetBackup Enterprise Servers

How to install NetBackup
For new NetBackup installations, install the software in the following order:

Install master server software.Step 1

Install media server software (NetBackup Enterprise only).Step 2

Install the NetBackup Remote Administration Console (optional).Step 3

Install client software.Step 4

Install any NetBackup add-on products (such as language packages).Step 5
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Before you proceed with any installation procedure, be sure to review the
installation requirements.

See “Requirements for Windows NetBackup server installation” on page 30.

About the upgrade order for NetBackup 7.5
If you use NetBackup OpsCenter, you must first upgrade those product components
before you upgrade to NetBackup 7.5. Upgrading OpsCenter first helps to ensure
that it can interact with the new features in NetBackup 7.5. For complete
instructions about how to upgrade NetBackup OpsCenter, see the NetBackup
OpsCenter Administrator's Guide.

The following describes the order in which to upgrade all of these products. If you
do not use NetBackup OpsCenter, upgrade NetBackup as described in the last step.

Upgrade OpsCenter Agent.Step 1

Upgrade OpsCenter Server.Step 2

Upgrade OpsCenter View Builder.Step 3

Upgrade your NetBackup environment in the following order:

■ Back up the current NetBackup databases.

■ Upgrade master servers.

■ Upgrade media servers.

■ Upgrade NetBackup Remote Administration Consoles.

■ Upgrade clients.

■ Upgrade any installed NetBackup add-on products (such as
language packs).

Note: If your current NetBackup environment uses a remote EMM
(an EMM installed on a media server), you must upgrade this server
first. Once you upgrade the remote EMM, you must upgrade all master
servers that communicate with it. NetBackup does not support the
use of a later version EMM server with an earlier version master server.

Step 4

The installation process automatically searches to determine if an earlier
NetBackup version exists on your system. The presence of an existing version
dictates that you are about to perform an upgrade.

Before you proceed with any upgrade, be sure to review the upgrade requirements.

See “Requirements for upgrading Windows servers to NetBackup 7.5” on page 33.

See “About NetBackup mixed version support” on page 26.
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See “Requirements for Windows NetBackup server installation” on page 30.

Installing or upgrading servers locally
Before you begin any upgrade to NetBackup 7.5, refer to the following topics to
help you prepare and plan for the upgrade:

See “About image metadata migration after upgrades to NetBackup 7.5” on page 15.

See “Planning for image metadata migration after an upgrade to NetBackup 7.5”
on page 19.

Caution: To help ensure a successful upgrade to NetBackup 7.5, please visit the
following NetBackup 7.5 Upgrade Portal for complete upgrade details:
http://www.symantec.com/docs/TECH74584

Use the following procedure to install or upgrade to NetBackup 7.5 on a local
computer.

To install NetBackup server software locally on Windows

1 Log on to the system where you want to install NetBackup. Be sure to log on
with administrator privileges.

2 For upgrades only, run a hot catalog backup. If an error occurs during the
upgrade, you can roll back to the previous version and still retain your
information from the catalog backup.

This step is especially important for upgrades from 6.x versions because cold
catalog backup support was discontinued starting with NetBackup 7.0.

Catalog backups are typically scheduled to occur automatically from a catalog
backup policy. You can also initiate a hot catalog backup manually as follows:

Note: If a catalog backup policy does not exist, you must first create and
configure one to run a hot catalog backup. For complete details, see the
NetBackup Administartor's Guide, Volume I.

■ In the NetBackup Administration Console, expand NetBackup
Management > Policies.

■ Select the catalog backup policy you want to run.

■ Select Actions > Manual Backup.

3 This step applies only to upgrades. For new installations, skip to the next
step.
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■ Deactivate all NetBackup policies as follows:

■ On the master server, open the NetBackup
Administration Console.

■ From the tree on the left, select Policies.

■ In the right pane, select all of the NetBackup
policies that appear.

■ Right-click on the highlighted policies and
select Deactivate.

For NetBackup
Administration Console users

Enter the following commands for the appropriate
policies:

■ For NetBackup policies, enter the following
command:

install_path\NetBackup\bin\admincmd\
bpplinfo policy_name -modify -inactive

For command-line users

■ Deactivate disk staging storage units as follows:

■ On the master server, open the NetBackup
Administration Console.

■ From the tree on the left, expand NetBackup
Management > Storage Units.

■ In the right pane, double-click on a disk staging
storage unit.

■ When the Change Storage Unit dialog box
appears, select Staging Schedule.

■ When the Disk Staging Schedule dialog box
appears, click the Exclude Dates tab.

■ Select the date in the calendar that matches the
date of the system upgrade, then click OK. The
storage unit is then disabled on that date.

■ Click OK to close the Disk Staging Schedule
dialog box, then click OK to close the Change
Storage Unit dialog box.

■ Repeat these tasks for each disk staging storage
unit.

For NetBackup
Administration Console users

■ Enter the following command:

install_path\netbackup\bin\admincmd\
bpschedulerep schedulename -excl
mm/dd/yyyy

For command-line users

Installing or upgrading server software
Installing or upgrading servers locally

60



■ Deactivate all media servers as follows:

■ On the master server, open the NetBackup
Administration Console.

■ From the tree on the left, select Media and
Device Management > Devices > Media
Servers.

■ In the right pane, select all media servers that
appear.

■ Right-click on the highlighted servers and select
Deactivate.

For NetBackup
Administration Console users

■ Enter the following command:

install_path\Volmgr\bin\vmoprcmd
-deactivate_host -h device_host

For command-line users

■ If the NetBackup Administration Console is open, you must close it now.

4 Start the NetBackup Installation Wizard with one of the following methods:

■ DVD media
Insert the NetBackup for Windows DVD in the drive. If Autorun is disabled,
navigate to the DVD drive and run Browser.exe.

■ ESD images (downloaded files)
Navigate to the directory where the images reside and run Browser.exe.
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5 On the initial browser screen (Home), click Installation.
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6 On the Installation screen, click Server Software Installation.
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7 On the Welcome screen, review the content and click Next.

Note: For upgrades to NetBackup 7.5, make sure that you read the Attention!
notice on the Welcome screen. Before you perform an upgrade, please proceed
to the NetBackup 7.5 Upgrade Portal.

8 On the License Agreement screen, do the following:

■ I agree to and accept the terms of the license agreement.
You must select this item to install the software.

■ Participate in the NetBackup Product Improvement Program.
By default, this option is enabled. To disable this option, click the check
box to remove the check mark.

■ Click Next.
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9 On the SymantecNetBackupInstallationType screen, provide the following
information:

For a local installation, select Install to thiscomputer
only.

Where to install

Select this option to install NetBackup default features
and settings.

Typical

Select this option to choose the NetBackup features to
install and the settings that you want.

Custom

Click Next.

10 On the NetBackupLicenseKeyandServerType screen, provide the following
information:

Enter the base product license key that you received
with your product.

For new installations, the license key that you provide
determines which components you can select. For
example, you can click the icon next to NetBackup
MasterServer only if you enter a master server license
key.

For upgrades, the license for the existing installation
type determines which components you can select.

License Key

Click this icon to install master server software.NetBackup Master Server

Click this icon to install media server software.NetBackup Media Server

11 This step applies only to Custom installations. For Typical installations, skip
to the next step.

This step describes how to select and configure the NetBackup Features,
NetBackup Port Numbers, and the NetBackup Services.

■ NetBackup Features
On this screen, you can select the features to install and where the
NetBackup files are installed.

Click the icon next to any feature and a drop-down
menu appears.

Select Install or Do not install.

Feature List
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By default, NetBackup files are installed to the
following location:

C:\Program Files\VERITAS

To change the folder destination where NetBackup is
installed:

■ Click Change.

■ Browse to the preferred location and designate a
new or an existing folder.

■ Click Next.

Note: For upgrades, you cannot change the destination.

Destination Folder

Click Next.

■ NetBackup Port Numbers
On this screen, you can change port numbers, if it is necessary in your
configuration.
You may need to change a port number if you encounter conflicts when
NetBackup and another industry product try to share the same port.
Another example is if a port conflict occurs with a firewall, which may
cause security issues.
To change a port number, select the port number that you want to replace
and type the new number.
Click Next.

■ NetBackup Services
On this screen, provide the following startup account and startup type
information for NetBackup services:

By default, this box is checked so that NetBackup
uses the built-in system account. When this box is
checked, the fields below it are disabled.

To specify a different system account:

■ Click this box to remove the check mark.

■ Enter the account information in the following
fields:

Username
Password
Domain

Use the built-in system
account
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This option determines whether NetBackup
services start automatically if you need to restart
the NetBackup host. The default is Automatic.

To start NetBackup services manually after a
restart, select Manual.

Startup

By default, job-related services are set to start
automatically after the installation or the upgrade
has completed.

To prevent job-related services from starting
automatically, click on the box to clear the check
mark.

Startjob-relatedNetBackup
services following
installation

Check this box to prevent a reboot while you
perform a remote installation. When you check
this box, processes that use the NetBackup
executables and DLLs are stopped.

Warning: For Oracle users, if you select this option,
you must take down your database before you
continue the installation.

Terminate NetBackup
processes

This option determines how the installation
proceeds if a restart is required as part of the
installation or upgrade.

If you select this option and the installation process
determines that a restart is required, the
installation (or upgrade) stops. The system is then
rolled back to its original state.

If you do not select this option, the installation (or
upgrade) proceeds even if the installation process
determines that a restart is required.

Abort install if a reboot is
required

Click Next.

12 On the NetBackupSystemNames screen, provide the following information:

For master server installations, enter the name of the
local computer.

For media server installations, you must change the
name to the master server name to which the media
server is configured.

Master Server Name

67Installing or upgrading server software
Installing or upgrading servers locally



Enter the names of any additional NetBackup master
servers and media servers that you want to
communicate with this server. Include the names of
computers where you plan to install NetBackup later.

To enter more than one name, separate each name
with a comma or press Enter after each name.

Additional Servers

This field appears only for NetBackup Enterprise media
server installations.

When you install media server software, this field
defaults to the local server name.

Media Server Name

The EMM (Enterprise Media Manager) server contains
all of the information about NetBackup volume
configuration and device configuration.

By default, NetBackup installs the EMM server on the
master server (this field is populated automatically
when you enter the Master Server Name). This
configuration is preferred and is the most efficient.

Note: Although the EMM server can be located on a
media server, Symantec recommends that you keep it
on the master server. To locate the EMM server on a
media server requires that you perform another
procedure. After all NetBackup server software (master
and media) is installed, you must move the NetBackup
database and the EMM server to the designated media
server. For complete details, refer to the NetBackup
Administration Guide for Windows, Volume I. See the
section "Moving the NetBackup Database from one
host to another".

Consider the following in regard to the EMM server:

■ Symantec does not support EMM server installation
on a CIFS-mount.

■ If the NetBackup system shares drives by using the
Shared Storage Option (SSO), all NetBackup servers
must use the same host to store device information.

For more information on EMM servers and EMM
databases, refer to the NetBackup Administrator's
Guide for Windows, Volume I.

EMM Server Name

Installing or upgrading server software
Installing or upgrading servers locally

68



OpsCenter is a Web-based administration and
management tool for NetBackup.

If you have an OpsCenter server or plan to install one,
enter the server name or the IP address for that server
here.

For a clustered server, do not use the virtual name.
Instead, use the actual host name of the cluster node.

OpsCenter Server Name
(Optional)

Click Next.

13 On the ReadytoInstalltheProgram screen, review the InstallationSummary
that shows your selections from the previous steps. Then select one of the
following options:

■ Click Install to start the installation.

■ Click Back to view the previous screens and make any changes, then return
to this screen and click Install.

■ Click Cancel to cancel the installation.

After you click Install, the installation process begins and a screen appears
that shows you the installation progress. This process may take several
minutes.

14 On the Installation Complete screen, select from the following options:

Symantec recommends that you enter additional
license keys now for any other NetBackup products
you plan to install.

■ To enter additional license keys, click Add Keys.

■ When the list of Current License Keys appears,
click AddKey to enter a new license key, then click
Add.

■ After all license keys are entered, close the Current
License Keys window.

Add Keys
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An installation log file provides detailed installation
information and shows whether any errors occurred.

Examine the installation log at the following location:

%ALLUSERSPROFILE%\Symantec\NetBackup\InstallLogs\

Search the installation log for the following error
indications:

■ Strings that include Return Value 3.

■ Important log messages that are color coded as
follows:

Yellow = warning.

Red = error.

View installation log file

Select one of the following to complete the installation:

■ If you are done installing software on all servers,
click the box next to Launch NetBackup
Administration Console now and click Finish.

The NetBackup Administration Console starts a
Configuration Wizard so that you can configure
your NetBackup environment.

■ If you have more server software to install, click
Finish.

You can move on to the next computer and install
the necessary server software.

Finish

15 Repeat the steps in this procedure for any other servers.

16 For upgrades, after all servers are upgraded, reactivate the following in the
order as shown:

■ All media servers

■ All disk staging storage units

■ All NetBackup policies

Warning: Do not reactivate any catalog backup policies until after the
image metadata migration has completed. Also, do not attempt any catalog
recovery operations until after the image metadata migration has
completed. Once the image metadata migration is finished, remember to
reactivate catalog backup policies.
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17 For upgrades to NetBackup 7.5, the image metadata migration must be
completed to finish the upgrade. Refer to the following information for
complete details:

■ See “About image metadata migration after upgrades to NetBackup 7.5”
on page 15.

■ Click on the following link to go to the NetBackup 7.5 Upgrade Portal and
review the NetBackup 7.5 Upgrade Guide:
http://www.symantec.com/docs/TECH74584
This guide describes the estimated migration times based on the migration
method and the number of images to be migrated.

■ See “Planning for image metadata migration after an upgrade to NetBackup
7.5” on page 19.

18 After all server software is installed or upgraded, you are ready to install or
upgrade client software.

See “About NetBackup client installation” on page 127.

See “About NetBackup license key requirements” on page 49.

Installing or upgrading servers remotely
Before you begin any upgrade to NetBackup 7.5, refer to the following topics to
help you prepare and plan for the upgrade:

See “About image metadata migration after upgrades to NetBackup 7.5” on page 15.

See “Planning for image metadata migration after an upgrade to NetBackup 7.5”
on page 19.

Caution: To help ensure a successful upgrade to NetBackup 7.5, please visit the
following NetBackup 7.5 Upgrade Portal for complete upgrade details:
http://www.symantec.com/docs/TECH74584

Use the following procedure to install or upgrade to NetBackup 7.5 on multiple
computers within your network.

To install or upgrade NetBackup servers remotely

1 Log on to a system with network access to all of the hosts where you want to
install NetBackup. Be sure to log on with administrator privileges.

2 For upgrades only, run a hot catalog backup. If an error occurs during the
upgrade, you can roll back to the previous version and still retain your
information from the catalog backup.
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This step is especially important for upgrades from 6.x versions because cold
catalog backup support was discontinued starting with NetBackup 7.0.

Catalog backups are typically scheduled to occur automatically from a catalog
backup policy. You can also initiate a hot catalog backup manually as follows:

Note: If a catalog backup policy does not exist, you must first create and
configure one to run a hot catalog backup. For complete details, see the
NetBackup Administartor's Guide, Volume I.

■ In the NetBackup Administration Console, expand NetBackup
Management > Policies.

■ Select the catalog backup policy you want to run.

■ Select Actions > Manual Backup.

3 This step applies only to upgrades. For new or initial installations, skip to the
next step.

■ Deactivate all NetBackup policies as follows:

■ On the master server, open the NetBackup
Administration Console.

■ From the tree on the left, select Policies.

■ In the right pane, select all of the NetBackup
policies that appear.

■ Right-click on the highlighted policies and
select Deactivate.

For NetBackup
Administration Console users

Enter the following commands for the appropriate
policies:

■ For NetBackup policies, enter the following
command:

install_path\NetBackup\bin\admincmd\
bpplinfo policy_name -modify -inactive

For command-line users

■ Deactivate disk staging storage units as follows:
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For NetBackup
Administration Console
users

■ On the master server, open the NetBackup
Administration Console.

■ From the tree on the left, expand NetBackup
Management > Storage Units.

■ In the right pane, double-click on a disk staging
storage unit.

■ When the ChangeStorageUnit dialog box appears,
select Staging Schedule.

■ When the Disk Staging Schedule dialog box
appears, click the Exclude Dates tab.

■ Select the date in the calendar that matches the
date of the system upgrade, then click OK. The
storage unit is then disabled on that date.

■ Click OK to close the DiskStagingSchedule dialog
box, then click OK to close the ChangeStorageUnit
dialog box.

■ Repeat these tasks for each disk staging storage
unit.

■ Enter the following command:

install_path\netbackup\bin\admincmd\
bpschedulerep schedulename -excl
mm/dd/yyyy

For command-line users

■ Deactivate all media servers as follows:

■ On the master server, open the NetBackup
Administration Console.

■ From the tree on the left, select Media and Device
Management > Devices > Media Servers.

■ In the right pane, select all media servers that
appear.

■ Right-click on the highlighted servers and select
Deactivate.

For NetBackup
Administration Console
users

■ Enter the following command:

install_path\Volmgr\bin\vmoprcmd
-deactivate_host -h device_host

For command-line users

4 Start the NetBackup Installation Wizard with one of the following methods:

■ DVD media

73Installing or upgrading server software
Installing or upgrading servers remotely



Insert the NetBackup for Windows DVD in the drive. If Autorun is disabled,
navigate to the DVD drive and run Browser.exe.

■ ESD images (downloaded files)
Navigate to the directory where the images reside and run Browser.exe.

5 On the initial browser screen (Home), click Installation.
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6 On the Installation screen, click Server Software Installation.
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7 On the Welcome screen, review the content and click Next.

Note: For upgrades to NetBackup 7.5, make sure that you read the Attention!
notice on the Welcome screen. Before you perform an upgrade, please proceed
to the NetBackup 7.5 Upgrade Portal.

8 On the License Agreement screen, do the following:

■ I agree to and accept the terms of the license agreement.
You must select this item to install the software.

■ Participate in the NetBackup Product Improvement Program.
By default, this option is enabled. To disable this option, click the check
box to remove the check mark.

■ Click Next.

Installing or upgrading server software
Installing or upgrading servers remotely

76



9 On the SymantecNetBackupInstallationType screen, provide the following
information:

For a remote installation, click Install to multiple
computers on your network.

Where to install

Select this option to install NetBackup default features
and settings.

Typical

Select this option to choose the NetBackup features to
install and the settings that you want.

Custom

Click Next.

10 On the NetBackupLicenseKeyandServerType screen, provide the following
information:
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Enter the base product license key that you received
with your product.

For new installations, the license key that you provide
determines which components you can select. For
example, you can click the icon next to NetBackup
MasterServer only if you enter a master server license
key.

For upgrades, the license that was used for the existing
installation type determines which components you
can select.

Note: The license key that you enter here gets pushed
to the other nodes. Your license key may enable add-on
products. If you push NetBackup to nodes that have
an add-on product already installed, your key works
for the add-on product(s).

During this installation process, the following occurs
to verify that you have proper credentials to perform
remote installations:

■ When you select a clustered system for installation,
NetBackup determines if you have proper
administrator credentials on all nodes in the
cluster. If you do not have the proper credentials,
the system is not added to the list.

■ If you have the proper credentials, NetBackup
performs a second check to determine if a license
key is needed. If a key is needed and one was not
entered, the system cannot be added to the list. You
must enter a valid license key to install on that
node. If you enter an invalid license key, this screen
remains visible until a valid key is entered.

License Key

Click this icon to install master server software.NetBackup Master Server

Click this icon to install media server software.NetBackup Media server

11 This step applies only to Custom installations. For Typical installations, skip
to the next step.

This step describes how to select and configure the NetBackupPortNumbers
and the NetBackup Services.

■ NetBackup Port Numbers
On this screen, you can change port numbers, if it is necessary in your
configuration.
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You may need to change a port number if you encounter conflicts when
NetBackup and another industry product try to share the same port.
Another example is if a port conflict occurs with a firewall, which may
cause security issues.
To change a port number, select the port number that you want to replace
and type the new number.
Click Next.

■ NetBackup Services
On this screen, provide the following startup account and startup type
information for NetBackup services:

By default, this box is checked so that NetBackup
uses the built-in system account. When this box is
checked, the fields below it are disabled.

To specify a different system account:

■ Click this box to remove the check mark.

■ Enter the account information in the following
fields:

User name
Password
Domain

Use the built-in system
account

This option determines whether NetBackup
services start automatically if you need to restart
the NetBackup host. The default is Automatic.

To start NetBackup services manually after a
restart, select Manual.

Startup

By default, job-related services are set to start
automatically after the installation or the upgrade
has completed.

To prevent job-related services from starting
automatically, click on the box to clear the check
mark.

Startjob-relatedNetBackup
services following
installation

Check this box to prevent a reboot while you
perform a remote installation. When you check
this box, processes that use the NetBackup
executables and DLLs are stopped.

Warning: For Oracle users, if you select this option,
you must take down your database before you
continue the installation.

Terminate NetBackup
processes
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This option determines how the installation
proceeds if a restart is required as part of the
installation or upgrade.

If you select this option and the installation process
determines that a restart is required, the
installation (or upgrade) stops. The system is then
rolled back to its original state.

If you do not select this option, the installation (or
upgrade) proceeds even if the installation process
determines that a restart is required.

Abort install if a reboot is
required

Click Next.

12 On the NetBackup System Names screen, enter the following:

Enter the names of any additional NetBackup servers
that you want to communicate with all of the servers
that you want to install. Include the names of
computers where you plan to install NetBackup later.

To enter more than one name, separate each name
with a comma or press Enter after each name.

Additional Servers

The EMM (Enterprise Media Manager) server name is
populated automatically. You may need to change it
based on the type of server that you want to install.

Specify the EMM server as described in the following
server installation types:

■ For master server installations:

To assign all master servers to use the same EMM
server, select EachsystemusestheEMMspecified
above.

To allow each master server to use its own EMM
server, leave the option Each system uses its own
EMM server selected (default).

■ For media server installations:

Specify the EMM server to be used by these media
servers.

EMM Server Name
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OpsCenter is a Web-based administration and
management tool for NetBackup.

If you have an OpsCenter server or plan to install one,
enter the server name or the IP address for that server
here.

For a clustered server, do not use the virtual name.
Instead, use the actual host name of the cluster node.

OpsCenter Server Name
(Optional)

Click Next.

13 On the Symantec NetBackup Remote Hosts and Features screen, specify
the hosts where you want NetBackup and any selected features installed.

■ Windows Destination Systems
Right-click Windows Destination Computers and select from the
drop-down menu, or use the following methods:

Click here to search the network for the hosts
where you want to install NetBackup.

■ On the AvailableSystems dialog box, select the
computer to add and click Next.

■ On the Remote Computer Login Credentials
dialog box, enter the User Name and the
Password of the account to be used to perform
the installation on the remote computers.

■ If you plan to install to multiple remote
computers, click the box next to Remember
UserNameandPassword. Selecting this option
prevents the need to enter this information for
each remote computer.

■ Click OK.

■ On the Remote Destination Folder dialog box,
verify or change the DestinationFolder where
NetBackup is installed.

The default location is C:\Program
Files\Veritas.

If you plan to install to multiple remote
computers and you want to use the same
location, click the box next to Use this folder
for subsequent systems. Selecting this option
prevents the need to enter the location for each
remote computer.

Browse
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Click here to import a text file that contains a list
of host names. When you create the text file, the
host names must be defined in the following
format:

Domain\ComputerName

Import

Click here to add a host manually.

■ On the Manual Remote Computer Selection
dialog box appears, enter the Domain and the
Computer Name, then click OK.

■ On the Remote Computer Login Credentials
dialog box, enter the User Name and the
Password of the account to be used to perform
the installation on the remote computers.

If you plan to add and install to multiple remote
computers, click the box next to Remember
UserNameandPassword. Selecting this option
prevents the need to enter this information for
each remote computer.

■ Click OK.

■ On the Remote Destination Folder dialog box,
verify or change the DestinationFolder where
NetBackup is installed.

The default location is C:\Program
Files\Veritas\.

If you plan to install to multiple remote
computers and you want to use the same
location, click the box next to Use this folder
for subsequent systems. Selecting this option
prevents the need to enter the location for each
remote computer.

■ Click OK.

Add

To remove a host from the Destination Systems
list, select the host and click here.

Remove

Click here to change the destination for NetBackup
file installation on the selected remote host.

Change

■ Features
Click a feature icon and select either Install or Do not install from the
drop-down menu .

■ Click Next.
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14 On the ReadytoInstalltheProgram screen, review the InstallationSummary
that shows your selections from the previous steps. Then select one of the
following options:

■ Click Install to initiate the installation.

■ Click Back to view the previous screens and make any changes, then return
to this screen and click Install.

■ Click Cancel to cancel the installation.

After you click Install, the installation process begins and a dialog box appears
that shows you the installation progress for each computer. Right-click on a
system in the dialog box to see the installation status.

Up to five installations occur simultaneously. When an installation is
completed, another one begins so that a maximum of five installations are
in progress.

15 When all remote installations have completed, click Finish

16 Examine the installation log on the following location:

%ALLUSERSPROFILE%\Symantec\NetBackup\InstallLogs\

An installation log file provides detailed installation information and shows
whether any errors occurred.

Note: When you perform a remote installation to multiple computers, this
option only lets you view the log for the local computer. Each computer that
you selected for installation contains its own installation log file. To view the
log file of a remote computer, open a Windows Explorer window and enter
\\<COMPUTERNAME>.

Search the installation log for the following error indications:

■ Strings that include Return Value 3.

■ Important log messages that are color coded as follows:
Yellow = warning.
Red = error.

17 For upgrades, after all servers are upgraded, reactivate the following in the
order as shown:

■ All media servers

■ All disk staging storage units

■ All NetBackup policies
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Warning: Do not reactivate any catalog backup policies until after the
image metadata migration has completed. Also, do not attempt any catalog
recovery operations until after the image metadata migration has
completed. Once the image metadata migration is finished, remember to
reactivate catalog backup policies.

18 For upgrades to NetBackup 7.5, the image metadata migration must be
completed to finish the upgrade. Refer to the following information for
complete details:

■ See “About image metadata migration after upgrades to NetBackup 7.5”
on page 15.

■ Click on the following link to go to the NetBackup 7.5 Upgrade Portal and
review the NetBackup 7.5 Upgrade Guide:
http://www.symantec.com/docs/TECH74584
This guide describes the estimated migration times based on the migration
method and the number of images to be migrated.

■ See “Planning for image metadata migration after an upgrade to NetBackup
7.5” on page 19.

19 After all server software is installed or upgraded, you are ready to install or
upgrade client software.

See “About NetBackup client installation” on page 127.

Requirements for Windows cluster installations and
upgrades

In addition to the normal server requirements, NetBackup cluster installations
require special considerations.

The following describes the guidelines for NetBackup cluster installations and
upgrades on Windows systems:

The source and the destination systems must run Windows
2003, 2008, or 2008 R2 Server.

Server operating system

To perform clustered installations, you must have
administrator privileges on all of the remote nodes in the
cluster. Symantec recommends that you keep a record of
all nodes in the cluster and what software exists on each
node.

Privileges
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Have the virtual name and IP address for NetBackup
available. You must provide this information during
installation.

NetBackup virtual name and
IP address

All clustered nodes must use the same operating system
version, service pack level, and NetBackup version. You
cannot run mixed server versions in a clustered
environment.

Operating system on nodes

New NetBackup 7.1 media servers cannot be clustered.

However, you can upgrade existing 6.x clustered media
servers to 7.1 and still keep them clustered.

Cluster support changes for
media servers

■ The shared disk that the NetBackup Group uses must
already be configured in the cluster and online on the
active node.

■ Install NetBackup from the node with the shared disk
(that is, the active node).

■ Computer or host names cannot be longer than 15
characters.

MSCS clusters

■ For SFW-HA 4.1 and SFW-HA 4.2:

Make sure that you install the patch from the following
Web site before you install versions 7.x or upgrade from
versions 6.x:

http://entsupport.symantec.com/docs/278307

■ All NetBackup disk resources must be configured in
Veritas Enterprise Administrator (VEA) before you install
NetBackup.

VCS clusters

When you upgrade clusters, the ltid and the robotic
daemons retrieve the device configuration for a particular
cluster node from the EMM database. The cluster node name
(provided by gethostname) stores or retrieves the device
configuration in the EMM database. The cluster node name
is used when any updates are made to the device
configuration, including any drive status that is made by
ltid. The cluster node name is only used to indicate where
a device is connected. The NetBackup virtual name is
employed for other uses, such as the robot control host.

Cluster node device
configuration and upgrades

Installing or upgrading servers in clustered environments
Before you begin any upgrade to NetBackup 7.5, refer to the following topics to
help you prepare and plan for the upgrade:
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See “About image metadata migration after upgrades to NetBackup 7.5” on page 15.

See “Planning for image metadata migration after an upgrade to NetBackup 7.5”
on page 19.

Caution: To help ensure a successful upgrade to NetBackup 7.5, please visit the
following NetBackup 7.5 Upgrade Portal for complete upgrade details:
http://www.symantec.com/docs/TECH74584

Use the following procedure to install or upgrade clustered environments to
NetBackup 7.5.

To install or upgrade NetBackup servers in clustered environments

1 Log on to the active node (the node with the shared disk). Be sure to log on
with administrator privileges.

2 For upgrades only, run a hot catalog backup. If an error occurs during the
upgrade, you can roll back to the previous version and still retain your
information from the catalog backup.

This step is especially important for upgrades from 6.x versions because cold
catalog backup support was discontinued starting with NetBackup 7.0.

Catalog backups are typically scheduled to occur automatically from a catalog
backup policy. You can also initiate a hot catalog backup manually as follows:

Note: If a catalog backup policy does not exist, you must first create and
configure one to run a hot catalog backup. For complete details, see the
NetBackup Administartor's Guide, Volume I.

■ In the NetBackup Administration Console, expand NetBackup
Management > Policies.

■ Select the catalog backup policy you want to run.

■ Select Actions > Manual Backup.

3 For upgrades only:

■ Deactivate all NetBackup policies as follows:
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For NetBackup
Administration Console users

■ On the master server, open the NetBackup
Administration Console.

■ From the tree on the left, select Policies.

■ In the right pane, select all of the NetBackup
policies that appear.

■ Right-click on the highlighted policies and
select Deactivate.

Enter the following commands for the appropriate
policies:

■ For NetBackup policies, enter the following
command:

install_path\NetBackup\bin\admincmd\
bpplinfo policy_name -modify -inactive

For command-line users

■ Deactivate disk staging storage units as follows:

■ On the master server, open the NetBackup
Administration Console.

■ From the tree on the left, expand NetBackup
Management > Storage Units.

■ In the right pane, double-click on a disk staging
storage unit.

■ When the Change Storage Unit dialog box
appears, select Staging Schedule.

■ When the Disk Staging Schedule dialog box
appears, click the Exclude Dates tab.

■ Select the date in the calendar that matches the
date of the system upgrade, then click OK. The
storage unit is then disabled on that date.

■ Click OK to close the Disk Staging Schedule
dialog box, then click OK to close the Change
Storage Unit dialog box.

■ Repeat these tasks for each disk staging storage
unit.

For NetBackup
Administration Console users

■ Enter the following command:

install_path\netbackup\bin\admincmd\
bpschedulerep schedulename -excl
mm/dd/yyyy

For command-line users

■ Deactivate all media servers as follows:
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For NetBackup
Administration Console users

■ On the master server, open the NetBackup
Administration Console.

■ From the tree on the left, select Media and
Device Management > Devices > Media
Servers.

■ In the right pane, select all media servers that
appear.

■ Right-click on the highlighted servers and select
Deactivate.

■ Enter the following command:

install_path\Volmgr\bin\vmoprcmd
-deactivate_host -h device_host

For command-line users

■ Take the following NetBackup resources offline:

Take all of the NetBackup group resources offline
except for the disk. Refer to the Microsoft Cluster
Administration documentation to determine how
to take the NetBackup group resources offline
through the cluster administrator interface.

MSCS clusters

Take the NetBackup resource offline.VCS clusters

4 Start the NetBackup Installation Wizard with one of the following methods:

■ DVD media
Insert the NetBackup for Windows DVD in the drive. If Autorun is disabled,
navigate to the DVD drive and run Browser.exe.

■ ESD images (downloaded files)
Navigate to the directory where the images reside and run Browser.exe.
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5 On the initial browser screen (Home), click Installation.

89Installing or upgrading server software
Requirements for Windows cluster installations and upgrades



6 On the Installation screen, click Server Software Installation.
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7 On the Welcome screen, review the content and click Next.

Note: For upgrades to NetBackup 7.5, make sure that you read the Attention!
notice on the Welcome screen. Before you perform an upgrade, please proceed
to the NetBackup 7.5 Upgrade Portal.

8 On the License Agreement screen, do the following:

■ I agree to and accept the terms of the license agreement.
You must select this item to install the software.

■ Participate in the NetBackup Product Improvement Program.
By default, this option is enabled. To disable this option, click the check
box to remove the check mark.

■ Click Next.
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9 On the SymantecNetBackupInstallationType screen, provide the following
information:

For a cluster installation, select InstallaclusteredMaster
Server.

This option is available only if the installation process
determines that your system is configured for a Windows
MSCS or VCS clustered environment.

Where to install

Select this option to install NetBackup default features and
settings.

Typical

Select this option to choose the NetBackup features to
install and the settings that you want.

Custom

Click Next.

10 On the NetBackupLicenseKeyandServerType screen, provide the following
information:
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Enter the base product license key that you received
with your product.

For new installations, the license key that you provide
determines which components you can select. For
example, you can click the icon next to NetBackup
MasterServer only if you enter a master server license
key.

For upgrades, the license for the existing installation
type determines which components you can select.

Note: The license key that you enter here gets pushed
to the other nodes. Your license key may enable add-on
products. If you push NetBackup to nodes that have
an add-on product already installed, your key works
for the add-on product(s).

During this installation process, the following occurs
to verify that you have proper credentials to perform
remote installations:

■ When you select a clustered system for installation,
NetBackup determines if you have proper
administrator credentials on all nodes in the
cluster. If you do not have the proper credentials,
the system is not added to the list.

■ If you have the proper credentials, NetBackup
performs a second check to determine if a license
key is needed. If a key is needed and one was not
entered, the system cannot be added to the list. You
must enter a valid license key to install on that
node. If you enter an invalid license key, this screen
remains visible until a valid key is entered.

License Key

Click this icon to install master server software.Master Server

11 This step applies only to Custom installations or upgrades. For Typical
installations or upgrades, skip to the next step.

This step describes how to select and configure the NetBackupPortNumbers
and the NetBackup Services.

■ NetBackup Port Numbers
On this screen, you can change port numbers, if it is necessary in your
configuration.
You may need to change a port number if you encounter conflicts when
NetBackup and another industry product try to share the same port.
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Another example is if a port conflict occurs with a firewall, which may
cause security issues.
To change a port number, select the port number that you want to replace
and type the new number.
Click Next.

■ NetBackup Services
On this screen, provide the following startup account and startup type
information for NetBackup services:

By default, this box is checked so that NetBackup
uses the built-in system account. When this box is
checked, the fields below it are disabled.

To specify a different system account:

■ Click this box to remove the check mark.

■ Enter the account information in the following
fields:

Username
Password
Domain

Use the built-in system
account

This option determines whether NetBackup
services start automatically if you need to restart
the NetBackup host. The default is Automatic.

To start NetBackup services manually after a
restart, select Manual.

Startup

By default, job-related services are set to start
automatically after the installation or the upgrade
has completed.

To prevent job-related services from starting
automatically, click on the box to clear the check
mark.

Startjob-relatedNetBackup
services following
installation

Check this box to prevent a reboot while you
perform a remote installation. When you check
this box, processes that use the NetBackup
executables and DLLs are stopped.

Warning: For Oracle users, if you select this option,
you must take down your database before you
continue the installation.

Terminate NetBackup
processes
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This option determines how the installation
proceeds if a restart is required as part of the
installation or upgrade.

If you select this option and the installation process
determines that a restart is required, the
installation (or upgrade) stops. The system is then
rolled back to its original state.

If you do not select this option, the installation (or
upgrade) proceeds even if the installation process
determines that a restart is required.

Abort install if a reboot is
required

Click Next.

12 On the NetBackupSystemNames screen, provide the following information:

For cluster installations, enter the cluster virtual server
name.

Master Server Name

Enter the names of any additional NetBackup master
servers and media servers that you want to
communicate with the master server that you identified
previously. Include the actual host names of the cluster
nodes where you plan to install NetBackup.

To enter more than one name, separate each name
with a comma or press Enter after each name.

Additional Servers

This field appears only for media server upgrades and
is populated automatically with the virtual host name
of the cluster.

Media Server Name
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The EMM (Enterprise Media Manager) server contains
all of the information about NetBackup volume
configuration and device configuration.

By default, NetBackup installs the EMM server on the
master server (this field is populated automatically
when you enter the Master Server Name). This
configuration is preferred and is the most efficient.

Note: Although the EMM server can be located on a
media server, Symantec recommends that you keep it
on the master server. To locate the EMM server on a
media server requires that you perform another
procedure. After all NetBackup server software (master
and media) is installed, you must move the NetBackup
database and the EMM server to the designated media
server. For complete details, refer to the NetBackup
Administration Guide for Windows, Volume I. See the
section "Moving the NetBackup Database from one
host to another".

Consider the following in regard to the EMM server:

■ Symantec does not support EMM server installation
on a CIFS-mount.

■ If the NetBackup system shares drives by using the
Shared Storage Option (SSO), all NetBackup servers
must use the same host to store device information.

For more information on EMM servers and EMM
databases, refer to theNetBackupAdministrationGuide
for Windows, Volume I.

EMM Server Name

OpsCenter is a Web-based administration and
management tool for NetBackup.

If you have an OpsCenter server or plan to install one,
enter the server name or the IP address for that server
here.

For a clustered server, do not use the virtual name.
Instead, use the actual host name of the cluster node.

OpsCenter Server Name
(Optional)

Click Next.

13 On the NetBackup Remote Hosts and Features screen, specify the remote
system information for installation on those computers.

■ On the initial screen, right-click Browse.
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■ On the Available Systems dialog box, select the computer that you want
to add. Control-click to select multiple computers.
Click Next.

■ On the Remote Computer Login Credentials dialog box, enter the user
name, password, and domain that NetBackup is to use on the remote
system(s).
If you intend to add more remote computers, click the check box next to
Remember user name and password.
When you provide credentials, you select cluster nodes and add them to
the WindowsDestinationSystems list. These are the nodes on which you
remotely install NetBackup. Make sure that you select your local host
when you select systems to install.
Each time you choose a system, NetBackup performs system and license
checks. For example, it verifies the system for a server installation that
matches the type that you selected, as follows:

Considers the remote to be verified.■ NetBackup not
installed

Compares the installation type on that system to the
installation type that you request.

■ NetBackup already
installed

Notifies you of the problem and disallows the choice.
One example of an invalid combination is to try to
install a Remote Administration Console on a remote
system that is already a master server.

■ Invalid combination

Notifies you of the problem and disallows the choice.■ Remote system not a
supported platform
or level

The installation procedure also verifies that you have proper administrator
credentials on the remote system. If you do not have administrator
credentials, the Enter Network Password screen appears, and prompts
you to enter the administrator’s user name and password.
Click OK and continue selecting destination systems.

This process repeats for each node that you select. You can elect to retain the
user name and password. In that case, you are prompted only when the user
name or password is not valid.

Note the following regarding the push-install process in a clustered
environment:
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■ You can install NetBackup on any number of nodes. However, the
clustering service sets the limit for the number of nodes in a cluster, not
NetBackup.

■ NetBackup add-on products, such as language packages, cannot be installed
with the push method. Add-on products must be installed on each
individual node in the cluster group. For instructions on how to install
these products, refer to the NetBackup documentation that supports each
product.

■ NetBackup pushes to the other nodes only the license key you enter at the
beginning of the installation. Your license key may enable add-on products.
If you push NetBackup to nodes that have an add-on product already
installed, your key works for that product.

Click Next.

14 On the Cluster Settings screen, you provide the virtual and the physical
network information.

For new installations and upgrades, the following configuration settings that
you enter apply to all nodes:

For new cluster server installations, select this option.Create a new Cluster
Group

To upgrade current or existing cluster servers, select this
option.

Upgrade existing
Cluster Group

To add a host to an existing cluster group, select this
option.

When you select this option, all other fields are filled
automatically except for PublicNetwork. You must select
the appropriate network manually.

Add node(s) to existing
Cluster Group
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The default cluster setting is IPv4.

Enter the following addresses:

■ Virtual IPv4 Address
The IP address to which the virtual server name should
resolve.

For new cluster installations, you must enter the
address manually.

For upgrades or if you add a new node to a current
cluster, the address field is populated automatically.

■ IPv4 Subnet Mask
Identifies a subnetwork so that IP addresses can be
shared on a local area network. This number correlates
directly to the virtual IP address of the cluster.

IPv4 Clusters

To enable IPv6 clusters, select this option.

Enter the following IP address:

■ Virtual IPv6 Address
The IPv6 address must be entered in CIDR format.

IPv6 Clusters

The name that is used to identify a NetBackup service group
or resource group. The resources in any resource group
are related and interdependent.

NBClusterGroupName

The name by which NetBackup is known in the cluster.

When you install the client software, this host name must
be added to the AdditionalServers field on the NetBackup
System Names screen.

The server uses this name when it communicates with the
client nodes.

Virtual Host Name

A directory on one of the shared disks in the cluster where
NetBackup stores configuration information. If the letter
for the disk (or drive) does not appear in the pull-down list,
enter only the letter.

Path to Shared Data

For NetBackup clustered environments, select a public
network that is assigned to the node of the cluster.

Warning: You must not select a private network that is
assigned to this cluster.

Public Network
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After you set all of the parameters, click this icon to
configure the cluster for use with NetBackup. The Next
icon is not available until after successful cluster
configuration.

The text box provides the following information about the
configuration:

■ Identifies any existing clusters or NetBackup cluster
groups.

■ Indicates a successful configuration.

■ Identifies any problems or errors that occurred during
the configuration (configuration failure).

Note: After a successful cluster configuration for new
installations or upgrades, if you click Cancel, a pop-up
message appears. The message asks if you are sure that
you want to proceed with the cancellation. To cancel the
installation and remove the new cluster group, click Yes.
To continue with the installation and retain the new cluster
group, click No and then click Next.

If the cluster configuration fails, see the NetBackup
Clustered Master Server Administrator's Guide for
information about how to resolve the problem.

Cluster Configuration

When the successful cluster configuration message appears, click Next.

15 On the ReadytoInstalltheProgram screen, review the InstallationSummary
that shows your selections from the previous steps. Then select one of the
following options:

■ Click Install to initiate the installation.

■ Click Back to view the previous screens and make any changes, then return
to this screen and click Install.

■ Click Cancel to cancel the installation.

After you click Install, the installation process begins and a dialog box appears
that shows you the installation progress for each computer. Right-click on a
system in the dialog box to see the installation status.

Up to five installations occur simultaneously. When an installation is
completed, another one begins so that a maximum of five installations are
in progress.

16 Examine the installation log on the following location:

%ALLUSERSPROFILE%\Symantec\NetBackup\InstallLogs\
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An installation log file provides detailed installation information and shows
whether any errors occurred.

Note: When you perform a cluster installation to multiple computers, this
option only lets you view the log for the local computer. Each computer that
you selected for installation contains its own installation log file. To view the
log file of a remote computer, open a Windows Explorer window and enter
\\<COMPUTERNAME>.

Search the installation log for the following error indications:

■ Strings that include Return Value 3.

■ Important log messages that are color coded as follows:
Yellow = warning.
Red = error.

17 For upgrades, after all servers are upgraded, reactivate the following in the
order as shown:

■ All media servers

■ All disk staging storage units

■ All NetBackup policies

Warning: Do not reactivate any catalog backup policies until after the
image metadata migration has completed. Also, do not attempt any catalog
recovery operations until after the image metadata migration has
completed. Once the image metadata migration is finished, remember to
reactivate catalog backup policies.

18 For upgrades to NetBackup 7.5, the image metadata migration must be
completed to finish the upgrade. Refer to the following information for
complete details:

■ See “About image metadata migration after upgrades to NetBackup 7.5”
on page 15.

■ Click on the following link to go to the NetBackup 7.5 Upgrade Portal and
review the NetBackup 7.5 Upgrade Guide:
http://www.symantec.com/docs/TECH74584
This guide describes the estimated migration times based on the migration
method and the number of images to be migrated.
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■ See “Planning for image metadata migration after an upgrade to NetBackup
7.5” on page 19.

19 After all server software is installed or upgraded, you are ready to install or
upgrade client software.

See “About NetBackup client installation” on page 127.

See “Post-installation tasks for NetBackup cluster environments” on page 102.

See “Requirements for Windows NetBackup server installation” on page 30.

Post-installation tasks for NetBackup cluster environments
After NetBackup server software is installed in a cluster, note the possible actions
you may need to take:

You may need to restart each of the cluster nodes after the
installation is complete.

Restart

Under normal circumstances, cluster configuration is one
of the final steps when you install NetBackup in a cluster.
If this step is not done or does not complete successfully,
you can use thebpclusterutil command from the active
node to perform this step.

For information on how to run bpclusterutil, see the
NetBackup Commands Reference Guide.

MSCS and VCS clusters

Any NetBackup resources that you took offline come back
online automatically.

MSCS clusters

See “Verifying Windows cluster installations or upgrades” on page 102.

Verifying Windows cluster installations or upgrades
The Cluster Administration console lets you verify the installation or upgrade
and view your current system structure.

To verify a successful MSCS cluster installation or upgrade through the Cluster
Administration console

1 During a cluster installation, you can open the Cluster Administration console
to see your current structure.

2 After you have completed the installation and the configuration process, the
console shows the new cluster group configuration.

Installing or upgrading server software
Requirements for Windows cluster installations and upgrades

102



To verify a successful VCS cluster installation or upgrade through the Cluster
Manager console

1 During a cluster installation, you can open the Cluster Administration console
to see your current structure.

2 After you have completed the installation and the configuration process, the
console shows the new cluster group configuration.

See “About NetBackup server configuration” on page 163.

About automatic file changes from an upgrade
When you upgrade from an earlier NetBackup version, certain customizable scripts
are overwritten. Before NetBackup overwrites these scripts, it saves copies of
them so that any modifications are preserved.

The following examples describe how this process works:

Your current NetBackup version is 6.5 and you modified
files in the goodies directory. For example:

C:\Program

Files\Veritas\NetBackup\bin\goodies

After an upgrade to NetBackup 7.x, the following directory
is created automatically and contains the modified files
from the earlier version:

C:\Program

Files\Veritas\NetBackup\goodies.6.5

You can use the scripts in this directory to replace the new
default versions that were installed with the upgrade.

Example 1: goodies directory

Your current NetBackup version is 6.5 and you modified
files in the bin directory. For example:

C:\Program Files\Veritas\NetBackup\bin

After an upgrade to NetBackup 7.x, the following directory
is created automatically and contains the modified files
from the earlier version:

C:\Program Files\Veritas\NetBackup\bin.6.5

You can use the scripts in this directory to replace the new
default versions that were installed with the upgrade.

Example 2: bin directory

Table 3-1 describes the files and scripts that are overwritten when you upgrade
from an earlier Windows version of NetBackup:
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Table 3-1 Overwritten files and scripts

Affected files and scriptsPath

All filesC:\Program

Files\Veritas\NetBackup\bin

All files

Note: Starting with NetBackup 7.0,nbmail.cmd
has been moved from c:\Program

Files\Veritas\NetBackup\bin to
c:\Program

Files\Veritas\NetBackup\bin\goodies.
To allow future upgrades to use this script, copy
nbmail to c:\Program
Files\Veritas\NetBackup\bin and modify
it there.

C:\Program

Files\Veritas\NetBackup\bin\goodies

Installing or upgrading NetBackup servers silently
A silent installation or upgrade avoids the need for interactive input in the same
manner as performing a remote installation. Silent NetBackup installations and
upgrades are not supported if you want to run the NetBackup services as a user
rather than the local system.

Before you begin any upgrade to NetBackup 7.5, refer to the following topics to
help you prepare and plan for the upgrade:

See “About image metadata migration after upgrades to NetBackup 7.5” on page 15.

See “Planning for image metadata migration after an upgrade to NetBackup 7.5”
on page 19.

Caution: To help ensure a successful upgrade to NetBackup 7.5, please visit the
following NetBackup 7.5 Upgrade Portal for complete upgrade details:
http://www.symantec.com/docs/TECH74584

To perform a silent installation or upgrade, you must first modify the appropriate
NetBackup script. After script modification, you can run the script to initiate the
silent installation or upgrade.

For upgrades, the script shuts down all NetBackup services so that the upgrade
can be initiated.
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If the script detects that other system processes still maintain a handle on any
NetBackup files, the upgrade fails. To identify which NetBackup processes are
still running, check the NetBackup Install log file at the following location:

%ALLUSERSPROFILE%\Symantec\NetBackup\InstallLogs

After you have manually stopped each of the identified processes, you can run
the upgrade script again.

Note: For Windows 2008 Server Core systems, you can only install or upgrade
NetBackup with this procedure.

To install or upgrade NetBackup server software silently

1 Log on as administrator to the system where you want to install or upgrade
NetBackup.

2 For upgrades only, run a hot catalog backup. If an error occurs during the
upgrade, you can roll back to the previous version and still retain your
information from the catalog backup.

This step is especially important for upgrades from 6.x versions because cold
catalog backup support was discontinued starting with NetBackup 7.0.

Catalog backups are typically scheduled to occur automatically from a catalog
backup policy. You can also initiate a hot catalog backup manually as follows:

Note: If a catalog backup policy does not exist, you must first create and
configure one to run a hot catalog backup. For complete details, see the
NetBackup Administartor's Guide, Volume I.

■ In the NetBackup Administration Console, expand NetBackup
Management > Policies.

■ Select the catalog backup policy you want to run.

■ Select Actions > Manual Backup.

3 Insert the NetBackup installation DVD or navigate to the location where the
ESD images (downloaded files) reside.

4 Open Windows Explorer and copy the contents of the X86 or the X64 directory
to a temporary directory on your hard drive. Choose the directory that is
associated with the platform type that you want to install.

5 Since the source files are read-only, you must change the permissions for the
copied files to allow the installation or the update.
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6 In the temporary directory where the copied files reside, select the appropriate
script to modify:

■ To install or upgrade a master server, edit silentmaster.cmd

■ To install or upgrade a media server, edit silentmedia.cmd

■ To install or upgrade a NetBackup Remote Administration Console, edit
silentadmin.cmd

7 Edit the following lines as needed for your installation:

■ SET ADDITIONALSERVERS=media1,media2,media3

Enter the names of any additional NetBackup master servers and media
servers that you want to communicate with this host. Include the names
of servers where you plan to install NetBackup later.
If no other servers are to communicate with this host, remove this line
from the script.

■ SET ABORT_REBOOT_INSTALL=0

This line lets you determine how you want the installation to continue if
a restart is required. Select from the following settings:

By default, a silent installation or upgrade does not
abort if it is determined that a restart is required.
If you leave this setting at 0, select one of the
following tasks:

■ After the installation or the upgrade is
complete, check the installation log to see if a
restart is required.

If the string in use appears anywhere in the
log, you must restart the system manually.

■ Force an automatic restart after the installation
or the upgrade is complete.

To force an automatic restart, before you run
the script, remove the following option from
the silent installation command script
(silent*.cmd):

REBOOT="ReallySuppress"

Warning: A forced restart occurs with no warning
to the user. It does not cancel the installation or
roll back the system to its original state.

0 (default)
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Select this setting to abort the installation or the
upgrade if it is determined that a restart is
required.

If a restart is needed, this setting cancels the
installation or the upgrade and the system is rolled
back to its original state.

1

8 Save the script and run it.

9 Examine the installation log at the following location:

%ALLUSERSPROFILE%\Symantec\NetBackup\InstallLogs\

Search the installation log for the following error indications:

■ Strings that include Return Value 3.

■ Starting with NetBackup 7.0, important log messages are color coded as
follows:
Yellow = warning.
Red = error.

10 For upgrades, after all servers are upgraded, reactivate the following in the
order as shown:

■ All media servers

■ All disk staging storage units

■ All NetBackup policies

Warning: Do not reactivate any catalog backup policies until after the
image metadata migration has completed. Also, do not attempt any catalog
recovery operations until after the image metadata migration has
completed. Once the image metadata migration is finished, remember to
reactivate catalog backup policies.

11 For upgrades to NetBackup 7.5, the image metadata migration must be
completed to finish the upgrade. Refer to the following information for
complete details:

■ See “About image metadata migration after upgrades to NetBackup 7.5”
on page 15.

■ Click on the following link to go to the NetBackup 7.5 Upgrade Portal and
review the NetBackup 7.5 Upgrade Guide:
http://www.symantec.com/docs/TECH74584
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This guide describes the estimated migration times based on the migration
method and the number of images to be migrated.

■ See “Planning for image metadata migration after an upgrade to NetBackup
7.5” on page 19.

After all server software is installed or upgraded, you are ready to install or
upgrade client software.

See “About NetBackup client installation” on page 127.

Restarting a system after a silent installation or upgrade
Symantec recommends that when you upgrade or install updates on a client or a
server, make sure that no backup processes are in progress. In rare cases, a restart
may be required.

To determine if a restart is necessary

1 After you have run the silent installation script, open the installation log at
the following location:

%ALLUSERSPROFILE%\Symantec\NetBackup\InstallLogs\

2 Search for the string in use. If files are listed as in use, a restart is required.

Upgrading NetBackup Servers to NetBackup
Enterprise Servers

To upgrade from NetBackup Server to NetBackup Enterprise Server, you must
enter the appropriate license key(s) in your current NetBackup Administration
Console.

To upgrade a NetBackup server to a NetBackup Enterprise server

1 Locate your NetBackup Enterprise Server license key.

2 Open the NetBackup Administration Console and choose Help>LicenseKeys.
The NetBackup License Key dialog box appears.

3 Click the New icon.
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4 Enter your license key in the New license key field and click Add.

The new license key appears in the field in the lower part of the dialog box.

For upgrades on Windows from a NetBackup server evaluation license key
to a permanent NetBackup Enterprise Server-based product license key,
restart the NetBackup services. When services are restarted, the new license
information is displayed when you select Help > About NetBackup
Administration Console.

If you add, delete, or change any license keys, you must restart the NetBackup
Administration Console.

5 Reboot the system if you are prompted.
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Installing alternative
administrative interfaces

This chapter includes the following topics:

■ About the NetBackup Remote Administration Console for Windows

■ About the NetBackup-Java Administration Console

About theNetBackupRemoteAdministrationConsole
for Windows

If your NetBackup server has no graphics display capabilities, you must install
an alternative administrative interface. It may also be desirable for various other
configurations, such as mixed environments that use the Windows and the UNIX
platforms.

Note: You can skip this section if you do not want or need to administer a
NetBackup server remotely from a Windows NetBackup client.

The NetBackup Remote Administration Console is an interface-only version of
NetBackup for Windows that you can use to administer NetBackup servers from
another computer. The computer that runs the NetBackup Remote Administration
Console does not require NetBackup software.

The following is a brief description of the NetBackup Remote Administration
Console operation:

■ The console lets you perform all NetBackup operations exactly like the
NetBackup Administration Console on a local Windows NetBackup server. You
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can create backup policies, manage volumes, view status, monitor tape drives,
and perform other operations.

■ The console displays the name of the server it administers, rather than a local
host name.

■ The console can only administer other NetBackup servers. It cannot act as a
master or a media server.

Installing the NetBackup Remote Administration Console
The NetBackup Remote Administration Console is supported on Windows Server
2003/XP, Windows Server 2008/Vista, and Windows Server 2008 R2/Windows 7.

Installation is a two-step process as follows:

■ Install the NetBackup Remote Administration Console.

■ Add the NetBackup Remote Administration Console host name to the server
list of the hosts that you want to administer.
You must also add the host names of the servers that you want to administer
to the server list on the host where you install the remote console.
The following table shows an example of the required server list entries for
each host. RAC1 refers to the Remote Administration Console.

Required server list entriesHost name

RAC1Master1

RAC1Media1

RAC1Media2

Master1, Media1, Media2RAC1

To install the NetBackup Remote Administration Console

1 On the computer where you want to install the NetBackup Remote
Administration Console, start the NetBackup Installation Wizard with one
of the following methods:

■ DVD media
Insert the NetBackup for Windows DVD in the drive. If Autorun is disabled,
navigate to the DVD drive and run Browser.exe.

■ ESD images (downloaded files)
Navigate to the directory where the images reside and run Browser.exe.

2 On the initial screen, click Installation.
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3 On the Installation screen, click Server Software Installation.

4 On the Welcome screen, review the content and click Next.

5 On the LicenseAgreement screen, accept the terms of the license agreement
and click Next.

6 On the Installation Type screen, select Install to this computer only, click
Typical, and then click Next.

7 On the NetBackup License Key and Server Type screen, select NetBackup
RemoteAdministrationConsole. You do not need a license key to install the
Remote Administration Console.

8 On the NetBackupSystemNames screen, provide the following information:

Enter the name of the local computer where you want
to install the remote console. (The name should appear
by default.)

Client Name

Enter the name of the NetBackup master server. (If
NetBackup master server software is installed on this
computer, the name should appear by default.)

Master Server

Enter the names of any additional NetBackup servers
that you want to allow access to this server. To enter
more than one name, separate each name with a
comma or press Enter after you enter each name.

Additional Servers

9 On the Ready to Install the Program screen, review the summary of your
selections. Then, click Install.

10 After the installation completes, do the following:

■ Click View Log to review the installation details.

■ Click Finish.
If you clicked the box next to LaunchNetBackupAdministrationConsole
now, the Remote Administration Console appears. If you did not click the
box, start the console by selecting Start > Programs > Symantec
NetBackup > NetBackup Administration Console.
This action starts the console on the local host, not on any remote host.

11 Add the required host names to the server lists of all hosts.

See “Configuring server lists for the NetBackup Remote Administration
Console” on page 114.
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Configuring server lists for the NetBackup Remote Administration
Console

The following methods are available to configure server lists for the NetBackup
Remote Administration Console:

■ Use the NetBackup Administration Console

■ On UNIX servers, edit the bp.conf file.

■ On Windows servers, edit the system registry.

To configure server lists for the NetBackup Remote Administration Console by
using the NetBackup Administration Console

1 On the NetBackup Administration Console in the left pane, click Host
Properties > Master Servers.

2 In the Master Servers window in the right pane, right-click the name of the
host server and select Properties.

3 In the Master Server Properties window, click the Servers icon from the
tree in the left pane.

4 In the Servers window, click Add.

5 Enter the name of the host that is to run the NetBackup Remote
Administration Console.

6 Click Add. The name of the host appears in the Additional Servers list.

7 Click Close and OK.

To configure server lists for the NetBackup Remote Administration Console by
editing the bp.conf file on UNIX servers

1 Log in to the master server as root.

2 Edit the following file:

/usr/openv/netbackup/bp.conf.

3 At the end of the SERVER = lines, add the following line:

SERVER = Remote-Administration-Console-machine-name

The Remote-Administration-Console-machine-name is the name of the
computer where you installed the NetBackup Remote Administration Console.

To configure server lists for the NetBackup Remote Administration Console by
editing the system registry on Windows servers

1 Log on to the master server as the administrator.

2 Click Start > Run....

Installing alternative administrative interfaces
About the NetBackup Remote Administration Console for Windows

114



3 Enter regedit.exe and click OK.

4 In the Registry Editor window, locate the following file:

HKEY_LOCAL_MACHINE\SOFTWARE\VERITAS\NetBackup\CurrentVersion\Config

5 In the right pane, double-click on Server.

6 In the Edit Multi-String window, enter the name of the Remote
Administration Console host and click OK.

7 Close the Registry Editor window.

Adding remote servers to administer from an existing NetBackup
Remote Administration Console

If you have an existing NetBackup Remote Administration Console installed and
you want to add a remote master server to administer, use this procedure.

To add a remote server to administer from an existing NetBackup Remote
Administration Console

1 Log on to the host where the NetBackup Remote Administration Console is
installed, and open the console.

2 In the left pane of the NetBackup Remote Administration Console, select Host
Properties > Master Server.

3 In the Master Servers window in the right pane, right-click the name of the
host server and select Properties (Read/Write).

4 In the Master Server Properties window, click the Servers tab.

5 In the Global Operations field, in the Add to all lists field, enter the host
name. Make sure that you enter the name of the host that is to run the
NetBackup Remote Administration Console.

6 Click the + icon (the name of the host appears in the AdditionalServers list),
then click OK.

About the NetBackup-Java Administration Console
The NetBackup-Java Administration Console can be used to administer one or
more UNIX or Windows NetBackup servers. It provides all of the standard
NetBackup server interfaces. The console can be used to create backup policies,
manage volumes, view status, monitor tape drives, and other operations.

On Java-capable UNIX hosts (servers and clients), this console is installed
automatically when you install NetBackup.
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On Windows hosts, this console must be installed separately.

Note: You can skip this section if you do not want or need to administer a
NetBackup server remotely from a Windows NetBackup client.

See “Installing the NetBackup Java Administration Console for version 7.5 on
Windows” on page 116.

Installing the NetBackup Java Administration Console for version 7.5
on Windows

Use the following guidelines when you install version 7.5 of the console:

■ Install the console from the NetBackup DVD for Windows or from the ESD
(downloaded) files.

■ Any computer that runs the console should have at least 512 MB of physical
memory.

To install version 7.5 of the NetBackup Java Administration Console on Windows

1 On the computer where you want to install the console, do one of the following:

■ Insert the appropriate DVD that contains the NetBackup software.
On Windows systems with Autorun enabled, the installation starts
automatically.
On Windows systems with Autorun disabled, navigate to the DVD directory
and run Browser.exe.

■ Navigate to the location where the downloaded files reside and run
Browser.exe.

2 On the initial screen, select Installation.

3 On the Installation screen, select Java Windows Administration Console
Installation.

4 On the Welcome screen, review the content and click Next.

5 On the License Agreement screen, accept the agreement and click Next.

6 On the NetBackup Installation Type screen, select Install to this computer
only and Typical. Then, click Next.

7 On the ReadytoInstalltheProgram screen, review the Installation Summary
and click Install.
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8 On the Installation Complete screen, click Finish.

9 To open the console, click Start > Programs > Symantec NetBackup >
NetBackup Java version 7.5.

In a site that contains multiple master servers, you can configure the systems so
that one NetBackupAdministrationConsole can access remote servers. Indicate
a remote server by using one of the following methods:

■ Use the File > Change Server menu command.

■ Use the NetBackup-Java Administration Console. Indicate a remote system
upon NetBackup login.

Note:To log in to any NetBackupAdministrationConsole, your login credentials
must be authenticated from the connecting master or media server. This is true
whether or not NetBackup Access Control (NBAC) is in use.

The NetBackup Administration Console on Windows and the NetBackup-Java
Administration Console on UNIX are backward-compatible in the following
situations:

■ From the console of an x.x.x (double-dot) or x.x.x.x (triple-dot) release to the
console of any release that shares the fist and second digits.
For example, a NetBackup 7.0.1 console can administer a NetBackup 7.0 master
server. However, a NetBackup 7.1 console (a single-dot release) cannot
administer a 7.0 or 7.0.1 master server because the second digits are not the
same. Figure 4-1 shows examples of each.

■ The NetBackup-Java Administration Console on UNIX offers an exception
when the -r option is used with the jnbSA command to start the console.

The -r option lets a x.x NetBackup-Java Administration Console connect to
another UNIX master server that is several versions earlier, regardless of
whether the second digit is the same.
For example, a 7.5 NetBackup-Java Administration Console can connect to a
NetBackup master server at 7.1, 7.0, 6.5, or 6.0. Figure 4-2 shows examples of
back-level console support.
Use the -r option to launch the console on the UNIX system as follows:

./jnbSA -r release_version

For example, to connect to a 7.0 master server from a 7.5 NetBackup-Java
Administration Console, enter the following on the 7.5 master server to start
the 7.0 console:
./jnbSA -r 7.0

If no -r option is specified, the default is the current NetBackup version.
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Figure 4-1 Examples of supported and unsupported back-level console
configurations

Yes No Yes

7.1.0.3

No

7.0

7.0.1 7.0.1

7.0 7.5

7.1.0.1

7.1

Figure 4-2 Examples of additional NetBackup-Java Administration Console
back-level support using the jnbSA -r option

7.5

Yes

6.0

7.1

6.5

Yes

See the NetBackup Installation Guide for information about installing earlier
versions of the NetBackup-Java Administration Console.

Methods for administering multiple versions of NetBackup
servers
Table 4-1 describes the available methods to administer NetBackup 7.5 with an
earlier version console. The order of the listed methods does not imply any
preference.

Table 4-1 Methods for administering multiple versions of NetBackup servers

NotesMethod

The earlier versions available in a
release are all of those supported in a
mixed version environment with the
current release. For example, all
versions back to and including the last
major release.

In the NetBackup 7.5 release, the 7.1,
7.0, 6.5.x, and the 6.0.x console versions
are available.

Earlier versions of the NetBackup-Java
Administration Console on UNIX platforms

Earlier versions of the NetBackup-Java
Administration Console on Windows platforms
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Table 4-1 Methods for administering multiple versions of NetBackup servers
(continued)

NotesMethod

From a Windows computer, you can
access the Java Windows
Administration Console on a UNIX
NetBackup server by using connectivity
software applications.

Remote display-back from UNIX servers

Use the appropriate NetBackup-Java
Administration Console on the
NetBackup server with the earlier
version of the console.

At the console on the NetBackup server

Installing multiple versions of the NetBackup-Java
Administration Console on Windows
To install multiple versions of the NetBackup interface in a mixed version
environment, note the following restrictions and guidelines:

Only the most recent version of the NetBackup-Java
Administration Console can be updated (or patched).

Updates

The NetBackup-Java Capabilities Authorization
configuration file (auth.conf), must always be located in
install_path\java. For example, C:\Program
Files\Veritas\java. The file must exist there regardless
of how many versions of the console are installed, or in
which directories they are installed.

The file is only used for administering NetBackup on this
Windows host, and default settings exist if the file is not
present. For more information about these defaults, see the
section "Authorizing NetBackup-Java users" in the
NetBackup Administrator’s Guide for Windows, Volume I.

auth.conf file

You must install each Java console version to a different
folder.

Console version location

To install earlier versions of the NetBackup-Java Administration Console

1 Insert the appropriate version NetBackup Windows installation media with
the NetBackup-Java Administration Console that you want to install.

2 Select one of the following consoles, based on the NetBackup version:
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■ For NetBackup 6.0 versions, select NetBackup Installation and click
Install Java Administration Console. Select whether you want to install
the 32-bit or the 64-bit console.

■ For NetBackup 6.5 versions, select NetBackup Installation and click
Install JavaWindowsAdministrationConsole. Select whether you want
to install the 32-bit or the 64-bit console.

■ For NetBackup 7.0 and 7.1 versions, select Installation and click Java
Windows Administration Console Installation.

3 If a different version of the Java console has already been installed, specify
a new folder location to prevent overwriting the earlier installation.

For example, specify C:\Program Files\Veritas\nbjava65 for version 6.5
Java consoles.

4 To complete the installation, click Finish.

Removing earlier versions of the NetBackup-Java
Administration Console on Windows
In some cases, you can remove earlier versions of the NetBackup-Java
Administration Console by using the Add/Remove Programs feature. You can
use this method if the version that you want to remove appears in the list of
programs.

If the version that you want to remove does not appear in the list of programs,
you must manually remove it. Use the following procedure.

Tomanually remove earlier versions of theNetBackup-Java Administration Console

1 Remove the folder where the earlier version NetBackup-Java Administration
Console is installed.

2 Remove the appropriate menu item from the Start>Programs>NetBackup
menu.

3 Remove any relevant desktop shortcuts.
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Removing NetBackup server
software

This chapter includes the following topics:

■ About NetBackup server software removal on Windows systems

■ Removing NetBackup server software on Windows systems

■ Removing NetBackup server software in a clustered environment

■ Removing NetBackup LiveUpdate from Windows systems

About NetBackup server software removal on
Windows systems

When you remove NetBackup server software, the process deletes the
VERITAS/NetBackupdirectories from the server. In a typical installation, NetBackup
add-on products and catalogs are located in this same directory path and are also
deleted.

You can remove NetBackup server software in the following ways:

■ Remove server software, configuration, and catalog information.

■ Remove server software and save NetBackup configuration and catalog
information.
If you intend to reinstall NetBackup, use this procedure to save the
configuration, catalog, and log file information before you remove NetBackup.
See “Removing NetBackup server software on Windows systems” on page 122.
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Removing NetBackup server software on Windows
systems

Use the following procedure to remove NetBackup server software and NetBackup
configuration and catalog information.

To remove NetBackup server software and NetBackup configuration and catalog
information

1 If the NetBackup Administration Console is open, close it.

If a console session is open when you try to remove NetBackup, a failure may
occur that forces you to restart this procedure.

2 Select Start > Settings > Control Panel.

3 On the Control Panel window, do one of the following:

■ For Windows XP/2003 and earlier, click Add/Remove Programs.

■ For Windows Vista/2008 and later, click Programs and Features.

4 On the Currently Installed Programs list, click Symantec NetBackup.

5 Click Remove.

For Windows 2008/Vista and later systems, after you click Yes to continue,
another dialog box appears to inform you that PBX is still running.

Symantec recommends that you click Do not close applications. (A reboot
will be required.) to continue with NetBackup removal. PBX is stopped and
restarted automatically as needed for removal.

6 Remove the NetBackup deduplication user directory as follows:

In the Documents and Settings directory, delete the purediskdbuser
directory.

Use the following procedure to remove NetBackup server software and save
NetBackup configuration and catalog information.

To remove NetBackup server software and save NetBackup configuration and
catalog information

1 If the NetBackup Administration Console is open, close it.

If a console session is open when you try to remove NetBackup, a failure may
occur that forces you to restart this procedure.

2 Select Start > Settings > Control Panel.

3 On the Control Panel window, do one of the following:

■ For Windows XP/2003 and earlier, click Add/Remove Programs.
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■ For Windows Vista/2008 and later, click Programs and Features.

4 In the Currently Installed Programs list, click Symantec NetBackup .

5 Click Change. This action lets you modify, repair, or remove NetBackup.

6 On the Program Maintenance dialog box, select Remove.

7 Clear the check mark next to RemoveallNetBackupConfiguration,Catalog,
and Log files to disable this function. (The box is checked by default.)

8 Click Next.

9 If you enabled NetBackup Access Control, NetBackup placed several files on
clients and servers. These files can be divided into the following categories:

These files are removed with NetBackup.NetBackup application
temporary files
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User cache files exist in their home directories, as
follows:

user\Local Settings\Application

Data\VERITAS\NetBackup

Files are generated in the \NetBackup directory by a
Single Sign-On operation of the NetBackup
Administration Console on the host where the console
runs. The NetBackup Administration Console cleans
these files when an exit function is performed, so the
directory does not always contain temporary files.
However, if a system crash were to occur, any files in
the directory may be left behind. With the console
shutdown, you can delete these files safely with no
data loss.

NetBackup also creates cached certificates for client
and server NetBackup applications. These files reside
within the\NetBackupdirectory. These files typically
have a name that is consistent with a DNS entry for a
network interface, such as machine.company.com.
Example directory entries are as follows:

user\Local Settings\Application

Data\VERITAS\NetBackup\pc.comp.com

user\Local Settings\Application

Data\VERITAS\NetBackup\dhcp

These files are created with the command bpnbat

-LoginMachine. If you plan to reinstall NetBackup on
the same computer at a later date, do one of the
following:

■ Preserve the certificates in the \NetBackup
directory.

■ If you do not preserve the certificates, you must
provide the computer identity password as
originally set on the Root+AB broker. As an
alternative, you can reset the password on the
Root+AB broker when you reinstall. See the
NetBackup Security and Encryption Guide.

Individual user (cache) files
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10 Remove the NetBackup deduplication user directory as follows:

Note:This step is necessary only if you upgraded to version 7.5 from a previous
or earlier version of NetBackup.

In the Documents and Settings directory, delete the purediskdbuser
directory.

Removing NetBackup server software in a clustered
environment

The following steps refer you to other documentation when you remove NetBackup
software from clustered machines.

To remove NetBackup from a clustered environment

1 Follow the instructions in your cluster documentation for removing a group.

2 Remove NetBackup from each node in the cluster.

See “To remove NetBackup server software and NetBackup configuration
and catalog information” on page 122.

No method exists to remove NetBackup from multiple nodes at the same time.

Removing NetBackup LiveUpdate from Windows
systems

NetBackup LiveUpdate and Symantec LiveUpdate share the same LiveUpdate
agent. When you remove LiveUpdate, you can no longer distribute NetBackup
updates automatically or other Symantec product updates.

Before you remove LiveUpdate, make sure that no other installed Symantec
products use LiveUpdate.

Use the following procedure to remove LiveUpdate files on Windows systems.

To remove NetBackup LiveUpdate on Windows systems

1 Select Start > Control Panel.

2 On the Control Panel window, do one of the following:

■ For Windows XP/2003 and earlier, click Add/Remove Programs.
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■ For Windows Vista/2008 and later, click Programs and Features.

3 Click on LiveUpdate and select Remove.
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Installing NetBackup client
software

This chapter includes the following topics:

■ About NetBackup client installation

■ About NetBackup client installation on Windows

■ About NetBackup client installation on UNIX

About NetBackup client installation
By definition, NetBackup servers are also clients. When you install NetBackup
server software, client software is also installed.

When you install client software, you perform a true client installation since no
server software is installed.

Client software can be installed locally at each individual computer or remotely.
The operating system determines which clients can be installed remotely.

A Windows host can only push client software to Windows
clients.

NetBackup does not need to be installed on the host that is
used to perform the remote client installation.

Windows

A NetBackup UNIX server can only push client software to
UNIX clients.

NetBackup software and client type software must be
installed on the server that is used to perform the remote
client installation.

UNIX
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About NetBackup client installation on Windows
The NetBackup client installation wizard for Microsoft Windows lets you select
the appropriate setup and installation options from a series of wizard screens.
After you select options, a window appears that lets you verify your selections
before the installation begins.

While the installation is in progress, a dialog box provides details of the installation
and the setup progress. When the installation is completed, a final window shows
the results.

Note the following when you install NetBackup client software on Windows
systems:

You cannot install NetBackup client software on the
computers that currently have NetBackup server software.
In these cases, you must first remove the NetBackup server
software.

See “Removing NetBackup server software on Windows
systems” on page 122.

Client installation
restrictions

■ By default on Windows 2003, 2008, and 2008 R2 Server
systems, only administrators have write permission to
the Program Files directory.

■ NetBackup writes log files and progress files to the
following location:

Program Files\VERITAS\NetBackup\Logs

To perform backups and restores with the Backup,
Archive, and Restore interface, users must have write
permission to the Logs directory. Users without write
permission to this directory receive an error message,
and the backup or restore is canceled. The administrator
account has write permission by default, but you must
ensure that other users also have write permission.

User permissions

About Windows client system requirements
The following describes the hardware and the software requirements for successful
installation of NetBackup client software.
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To install NetBackup client software locally, the system
must meet the following configuration requirements:

■ Microsoft Windows 2003/XP, Windows 2008/Vista, or
Windows 2008 R2/Windows 7

■ Any TCP/IP transport that is Windows Sockets
compliant. (Use of the TCP/IP transport that comes with
the server or the operating system is recommended.)

■ A network adapter that your TCP/IP transport supports

Local installation

To install NetBackup client software remotely, the system
must meet the following configuration requirements:

■ All the requirements for local installations must be met.

■ The source system must run Windows 2003, 2008, or
2008 R2 Server.

■ Administrator privileges are required for the user that
performs remote installations.

Remote installation

The NetBackup client version that you install must be the
same or earlier than the installed version of NetBackup
server software. Later client versions cannot be used with
earlier server versions.

See “About NetBackup mixed version support” on page 26.

NetBackup version
compatibility

About Windows client installation methods
You can install NetBackup clients on Windows systems with the following methods:

The installation wizard installs the client software only on
the computer where you run the installation.

See “Installing NetBackup Windows clients locally”
on page 130.

Local installation

The installation wizard scans the network for available
clients where you can install the client software.

The source computer must run Windows 2003, 2008, or
2008 R2 Server.

Also, a remote installation requires system administrator
privileges.

Note: You cannot install clients remotely from NetBackup
Windows servers to UNIX computers.

See “Installing NetBackup Windows clients remotely”
on page 133.

Remote installation
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A silent installation is a process that does not require
interactive input. However, you must edit the
silentclient.cmd file before you run it.

See “Installing NetBackup Windows clients silently”
on page 139.

Silent installation

See “About NetBackup client installation” on page 127.

See “About the NetBackup preinstallation Environment Checker” on page 35.

Installing NetBackup Windows clients locally
Follow these instructions to install the NetBackup client software on your local
Windows system. You can stop the installation process at any time by clicking
Cancel or by clicking Back to return to the previous window.

Note:After client installation, you may need to restart the system for the changes
to take effect.

To install NetBackup client software locally on Windows systems

1 Log on as administrator on the host where you want to install the client
software.

2 Start the NetBackup Installation Wizard with one of the following methods:

■ DVD media
Insert the NetBackup for Windows DVD in the drive. If Autorun is disabled,
navigate to the DVD drive and run Browser.exe.

■ ESD images (downloaded files)
Navigate to the directory where the images reside and run Browser.exe.

3 On the initial screen, select Installation.

4 On the Installation screen, select Client Software Installation.

5 On the Welcome screen, review the content and click Next.

6 On the License Agreement screen, accept the terms of the agreement and
click Next.
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7 On the Symantec NetBackup Client Installation Type screen, provide the
following information:

For a local installation, select Install to thiscomputer
only.

Where to install

Select this option to install NetBackup default features
and settings.

Typical

Select this option to choose the NetBackup features to
install and the settings that you want.

Custom

Click Next.

8 This step applies only to Custom installations. For Typical installations, skip
to step 10.

On the Symantec NetBackup Client Features screen, you can select the
features to install and where the NetBackup files are installed.

Click the icon next to any feature and a drop-down
menu appears.

Select Install or Do not install.

Feature List

By default, NetBackup files are installed to the
following location:

C:\Program Files\VERITAS

To change the folder destination where NetBackup is
installed:

■ Click Change.

■ Browse to the preferred location and designate a
new or an existing folder.

■ Click Next.

Note: For upgrades, you cannot change the destination.

Destination Folder

9 This step applies only to Custom installations. For Typical installations, skip
to the next step.

On the NetBackup Options screen, select from the following options:
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Enable or disable the following options:

■ Start NetBackup Client Service Automatically
By default, this option is enabled so that NetBackup
services are available immediately after system
startup.

■ StartNetBackupClientJobTrackerAutomatically
By default, this option is disabled. To start this
option manually after installation, click Start>All
Programs > Symantec NetBackup > NetBackup
Client Job Tracker.

At System Startup

On this screen, you can change port numbers, if it is
necessary in your configuration.

You may need to change a port number if you
encounter conflicts when NetBackup and another
industry product try to share the same port. Another
example is if a port conflict occurs with a firewall,
which may cause security issues.

To change a port number, select the port number that
you want to replace and type the new number.

Ports

Click Next.

10 On the NetBackup Services screen, provide the following startup account
and startup type information for NetBackup client services:

By default, this box is checked so that NetBackup uses
the built-in system account. When this box is checked,
the fields below it are disabled.

To specify a different system account:

■ Click this box to remove the check mark.

■ Enter the account information in the following
fields:

Username
Password
Domain

Use the built-in system
account
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This option determines how the installation proceeds
if a restart is required as part of the installation or
upgrade.

If you select this option and the installation process
determines that a restart is required, the installation
(or upgrade) stops. The system is then rolled back to
its original state.

If you do not select this option, the installation (or
upgrade) proceeds even if the installation process
determines that a restart is required.

Abort install if a reboot is
required

11 On the NetBackupSystemNames screen, the following fields are populated
automatically. Normally, changes are not required. Except for the Client
Name, you can make changes as needed for your configuration.

Do not change this name.Client Name

If necessary, change this name to the appropriate
master server where the client backup images are to
be stored.

Master Server Name

Enter all of the master server and media server names
that you want this client to access.

Additional Servers

12 On the ReadytoInstalltheProgram screen, review the InstallationSummary
that shows your selections from the previous steps. Then select one of the
following options:

■ Click Install to start the installation.

■ Click Back to view the previous screens and make any changes, then return
to this screen and click Install.

■ Click Cancel to cancel the installation.

After you click Install, the installation process begins and a screen appears
that shows you the installation progress. This process may take several
minutes.

13 On the Installation Complete screen, click Finish.

Installing NetBackup Windows clients remotely
Use this procedure to install NetBackup client software to multiple computers on
your network, including the local computer. You can stop the installation process
at any time by clicking Cancel.
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When you install Windows clients remotely, note the following:

Review the requirements for Windows client installation.

See “About Windows client system requirements”
on page 128.

Requirements

You must have administrator privileges on the remote
clients for the NetBackup installation to complete
successfully.

Privileges

During installation, the client name is written to the registry
in lowercase. For backups to work, the policies on the
NetBackup server must specify the client names in
lowercase.

Client name entries

You may need to restart the local or the remote systems for
the changes to take effect. A message appears to alert you
if a restart is needed.

Reboot after installation

To install NetBackup client software remotely on Windows systems

1 Log on as administrator on the host or the system server.

2 Start the NetBackup Installation Wizard with one of the following methods:

■ DVD media
Insert the NetBackup for Windows DVD in the drive. If Autorun is disabled,
navigate to the DVD drive and run Browser.exe.

■ ESD images (downloaded files)
Navigate to the directory where the images reside and run Browser.exe.

On the initial screen (Home), select Installation.

3 On the Installation screen, select Client Software Installation.

4 On the Welcome screen, review the content and click Next.

5 On the License Agreement screen, accept the terms of the agreement and
click Next.
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6 On the Symantec NetBackup Client Installation Type screen, provide the
following information:

For remote installation, select Install to multiple
computers on your network.

The procedure does not install the client on the local
host unless you add it to the list of systems that you
want to install.

Where to install

Select this option to install NetBackup default features
and settings.

Typical

Select this option to choose the NetBackup features to
install and the settings that you want.

Custom

7 This step applies only to Custom installations. For Typical installations, skip
to the next step.

On the NetBackup Options screen, select from the following options:

Enable or disable the following options:

■ Start NetBackup Client Service Automatically
By default, this option is enabled so that NetBackup
services are available immediately after system
startup.

■ StartNetBackupClientJobTrackerAutomatically
By default, this option is disabled. To start this
option manually after installation, click Start>All
Programs > Symantec NetBackup > NetBackup
Client Job Tracker.

At System Startup

On this screen, you can change port numbers, if it is
necessary in your configuration.

You may need to change a port number if you
encounter conflicts when NetBackup and another
industry product try to share the same port. Another
example is if a port conflict occurs with a firewall,
which may cause security issues.

To change a port number, select the port number that
you want to replace and type the new number.

Ports

8 On the NetBackup Services screen, provide the following startup account
and startup type information for NetBackup client services:
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By default, this box is checked so that NetBackup uses the built-in
system account. When this box is checked, the fields below it are
disabled.

To specify a different system account:

■ Click this box to remove the check mark.

■ Enter the account information in the following fields:

Username
Password
Domain

Use the built-in
system account

Check this box to prevent a reboot while you perform a remote
installation. When you check this box, processes that use the
NetBackup executables and DLLs are stopped.

Warning: For Oracle users, if you select this option, you must
take down your database before you continue the installation.

Terminate
NetBackup
processes

This option determines how the installation proceeds if a restart
is required as part of the installation or upgrade on the remote
system.

If you select this option and the installation process determines
that a restart is required, the installation (or upgrade) stops. The
system is then rolled back to its original state.

If you do not select this option, the installation (or upgrade)
proceeds even if the installation process determines that a restart
is required.

Abort install if a
reboot isrequired

9 On the NetBackupSystemNames screen, the following fields are populated
automatically. Change these fields to meet your specific needs.

If necessary, change this name to the appropriate
master server where the client backup images are to
be stored.

Master Server Name

Enter all of the master server and media server names
that you want the clients to access.

Additional Servers

10 On the Symantec NetBackup Remote Hosts and Features screen, specify
the hosts where you want NetBackup and any selected features installed.

■ Destination Systems
Right-click the Windows Destination Computers icon and select from
the drop-down menu , or use the following icons:
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Click here to search the network for the hosts
where you want to install NetBackup.

■ On the AvailableSystems dialog box, select the
computer to add and click Next.

■ On the Remote Computer Login Credentials
dialog box, enter the User Name and the
Password of the account to be used to perform
the installation on the remote computers.

■ If you plan to install to multiple remote
computers, click the box next to Remember
UserNameandPassword. Selecting this option
prevents the need to enter this information for
each remote computer.

■ Click OK.

■ On the Remote Destination Folder dialog box,
verify or change the DestinationFolder where
NetBackup is installed.

The default location is C:\Program
Files\Veritas.

If you plan to install to multiple remote
computers and you want to use the same
location, click the box next to Use this folder
for subsequent systems. Selecting this option
prevents the need to enter the location for each
remote computer.

Browse

Click here to import a text file that contains a list
of host names. When you create the text file, the
host names must be defined in the following
format:

Domain\ComputerName

Import
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Click here to add a host manually.

■ On the Manual Remote Computer Selection
dialog box appears, enter the Domain and the
Computer Name, then click OK.

■ On the Remote Computer Login Credentials
dialog box, enter the User Name and the
Password of the account to be used to perform
the installation on the remote computers.

If you plan to add and install to multiple remote
computers, click the box next to Remember
UserNameandPassword. Selecting this option
prevents the need to enter this information for
each remote computer.

■ Click OK.

■ On the Remote Destination Folder dialog box,
verify or change the DestinationFolder where
NetBackup is installed.

The default location is C:\Program
Files\Veritas.

If you plan to install to multiple remote
computers and you want to use the same
location, click the box next to Use this folder
for subsequent systems. Selecting this option
prevents the need to enter the location for each
remote computer.

■ Click OK.

Add

To remove a host from the Destination Systems
list, select the host and click here.

Remove

Click here to change the destination for NetBackup
file installation on the selected remote host.

Change

■ Features
Click a feature icon and select either Install or Do not install from the
drop-down menu .

■ Click Next.

11 On the ReadytoInstalltheProgram screen, review the InstallationSummary
that shows your selections from the previous steps. Then select one of the
following options:

■ Click Install to initiate the installation.

■ Click Back to view the previous screens and make any changes, then return
to this screen and click Install.
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■ Click Cancel to cancel the installation.

After you click Install, the installation process begins and a screen appears
that shows you the installation progress for each computer. This process may
take several minutes.

Up to five remote installations occur simultaneously. When a remote
installation is completed, another one begins so that a maximum of five
installations are in progress.

If you click Cancel after you click Install, the installation does not stop
immediately. Installation continues on all remote hosts where the installation
has already started. Any specified hosts after that point do not get client
software installed.

NetBackup considers any remote installations that were completed when you
clicked Cancel to be successful.

12 Examine the installation log on the following location:

%ALLUSERSPROFILE%\Symantec\NetBackup\InstallLogs\

An installation log file provides detailed installation information and shows
whether any errors occurred.

Note: When you perform a remote installation to multiple computers, this
option only lets you view the log for the local computer. Each computer that
you selected for installation contains its own installation log file. To view the
log file of a remote computer, open a Windows Explorer window and enter
\\<COMPUTERNAME>.

Search the installation log for the following error indications:

■ Strings that include Return Value 3.

■ Starting with NetBackup 7.0, important log messages are color coded as
follows:
Yellow = warning.
Red = error.

Installing NetBackup Windows clients silently
A silent installation process does not require interactive input. It does, however,
require that you edit the silentclient.cmd file before you run it.

Silent installations of NetBackup clients are not supported if you want to run the
NetBackup services as a user instead of a local administrator.
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To install NetBackup with a custom services account, refer to the following topics:

See “Installing NetBackup Windows clients locally” on page 130.

See “Installing NetBackup Windows clients remotely” on page 133.

Use the following procedure to perform a silent installation of a local NetBackup
client.

To perform a silent installation of NetBackup client software on Windows

1 Insert the NetBackup installation DVD in the drive or navigate to the location
where the ESD images (downloaded files) reside.

2 In a Microsoft Windows Explorer window, navigate to the DVD drive.

3 Copy the contents of the one of the following directories to a temporary folder
on your hard drive. For example, C:\temp.

■ PC_Clnt\x86

■ PC_Clnt\x64

4 Since the original source files are read-only, change the permissions for the
copied files on the hard drive to allow the update.

5 In the temporary directory, use a text editor to edit the silentclient.cmd

file so the script installs the client software as needed.

6 Run the silentclient.cmd script.

7 To verify that the installation was successful, check the installation log file
in the following directory:

%ALLUSERSPROFILE%\Symantec\NetBackup\InstallLogs

How to configure NetBackup clients
You can configure NetBackup clients by performing one of the following actions:

■ Start the Backup, Archive, and Restore interface.

■ Click File > Specify NetBackup Machines.

To add servers or media
servers:

■ Start the Backup, Archive, and Restore interface.

■ Click File > NetBackup Client Properties.

To display and change the
client properties:
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■ Open the NetBackup Administration Console.

■ Expand Host Properties and click Clients.

■ In the right pane, right-click on the client and choose
Properties.

In the dialog box that appears, on the Servers tab, all
NetBackup servers that require access to your Windows
client must be listed.

To display and change the
server properties:

For complete information on client configuration, see the NetBackup
Administrator's Guide, Volume I.

About NetBackup client installation on UNIX
You can install UNIX clients either locally at the client computer or remotely from
your UNIX NetBackup server. To install client software remotely from a UNIX
NetBackup server, the client type software must first be installed on the UNIX
server.

Note:Macintosh OS X clients are UNIX-based clients. Follow the same UNIX client
installation procedures in this section.

Note the following when you install NetBackup client software on UNIX systems:
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Starting with NetBackup 7.0, many of the add-on products
and database agents are now installed with the NetBackup
client package. Separate installation for these products is
no longer needed.

The following products are now included in the NetBackup
7.5 client package (if the platform supports the product):

■ BMR Boot server

■ DB2

■ Encryption

■ Informix

■ LiveUpdate agent

■ Lotus Notes

■ Oracle

■ SAP

■ Snapshot Client

■ Sybase

The binaries for the listed products are laid down with the
client package. A valid license is still required to enable the
product. If product configuration was required previously
(such as db2_config), configuration is still required.

The French, Japanese, and Chinese language packages
remain as separate add-ons. The process to install and
upgrade these products remains the same.

UNIX package consolidation

The gzip and the gunzip commands must be installed on
each system. The directories where the commands are
installed must be part of the root user’s PATH environment
variable setting.

gzipandgunzipcommands

To initiate a backup or a restore from a UNIX client, the
following graphical interfaces are available:

■ Clients that are compatible with NetBackup-Java may
use the NetBackup-Java interface (jbpSA).

Refer to the NetBackup Release Notes for a list of
NetBackup-Java capable hosts.

■ Clients that are not compatible with NetBackup-Java can
use the bp interface. They also support a login from any
NetBackup 7.5 UNIX server’s NetBackup client console
with the jbpSA command.

Clients that are not compatible with NetBackup-Java are
Macintosh OS X, IBM pSeries Linux, and FreeBSD.

NetBackup-Java
compatibility
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About UNIX client installation methods
You can install NetBackup clients on UNIX systems with the following methods:

■ This method installs the client software on the computer
where you run the installation script.

■ To install clients to a location other than the default,
you must create and link a directory before you install
the client software. First create the directory where you
want the software to reside, then create /usr/openv
as a link to that directory.

■ On IBM zSeries Linux clients, you must transfer the
NetBackup DVD or ESD image contents to a location that
is readable by the virtual Linux environment. You can
transfer the image with FTP or NFS mounting
commands.

See “Installing UNIX clients locally” on page 144.

Local installations
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■ You can "push" the client software from your UNIX
NetBackup server to your UNIX client computers. The
UNIX client must be a true client and not a media server
or a master server. The preferred installation method is
to push the client software.

■ Before you can push to a UNIX client, you must first
install the NetBackup client type software on the server.
Then, you must create a policy that includes the client
name.

Refer to the NetBackup Installation Guide for UNIX and
Linux. See the section "Installing client type software
on a master server".

■ You cannot install Windows client software remotely
from a NetBackup UNIX server. Firewalls can also
prevent remote client installation.

■ Clients such as the IBM zSeries Linux may not have a
locally mounted DVD device or access to the NetBackup
DVD or ESD images. In these cases, you must push the
client software from a UNIX master server or a media
server.

■ The following remote installation methods are available:

See “Installing client software with the ftp method”
on page 149.

See “Installing client software with the rsh method”
on page 146.

See “Installing client software with the ssh method”
on page 151.

See “Installing client software with the sftp method”
on page 151.

Remote (push) installations

See “About NetBackup client installation” on page 127.

Installing UNIX clients locally
The following procedure installs the NetBackup client software on a local computer.

To install client software locally on a UNIX client

1 Use one of the following methods to start the installation script:
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■ Insert the NetBackup UNIX Clients DVD into the
drive.

See “About the NetBackup media kit” on page 28.

■ If necessary, mount the DVD.

■ Enter the following command:

cd_directory/install

The cd_directory is the path to the directory where
you can access the DVD.

DVD

■ Navigate to the location where the installation
images reside.

■ Enter the following command:

./install

ESD images (downloaded
files)

2 When the following message appears, press Enter to continue:

Installing NetBackup Client Software.

Do you wish to continue? (y/n) [y]

The client binaries represent the operating system versions where the binaries
were compiled. The binaries typically function perfectly on later versions of
the operating system. For example, HP PA-RISC 11.11 binaries also are used
on the HP PA-RISC 11.23 level of the operating system. The installation
procedure attempts to load the appropriate binaries for your system. If the
script does not recognize the local operating system, it presents choices.

3 Follow the prompts to complete the installation.

4 After the installation is complete, select Exit from this Script.

About remote installation methods for UNIX clients
You can push the client software from a UNIX master server to a client host by
using the following methods:

■ rsh

See “Installing client software with the rsh method” on page 146.

■ ftp

See “Installing client software with the ftp method” on page 149.

■ ssh

See “Installing client software with the ssh method” on page 151.
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■ sftp

See “Installing client software with the sftp method” on page 151.

Note: For installation in clustered environments, enter the virtual name for the
NetBackup server and not the actual local host name. You can only push client
software from the active node.

Installing client software with the rsh method
Before you perform this procedure, read the following guidelines:

To use this method, the UNIX client must have an entry for
the server in its /.rhosts file. The /.rhosts entries
enable software installation, but they are not necessary for
correct operation of NetBackup software.

Client /.rhosts file

If you want to install client software to a location other than
the default, you must first create and link to the desired
directory. Create the directory where you want the client
software to reside, and then create /usr/openv as a link
to that directory.

Client software location

Make sure that the clients are assigned to a backup policy.Backup policies

By default, this operating system version does not enable
the Remote Shell daemon (rshd). Run the following
command to enable the daemon:

launchctl load -w

/System/Library/LaunchDaemons/shell.plist

For Macintosh OS X

To install client software from a UNIX master server to UNIX clients with the rsh
method

1 Start the NetBackup Administration Console.

2 On the Login dialog box, provide the name of the NetBackup server that
contains the policy configuration with the clients.

You can install the client software only from the NetBackup server that you
specify in the Login dialog box when you start the interface. The clients must
be defined in a policy on this NetBackup server.

3 In the main NetBackup Administration Console window, do the following:

■ In the left pane where the master server properties appear, click the icon
next to NetBackupManagement. The tree expands to show the available
options.
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■ In the center All Policies pane, select the master server.
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4 Click Actions > Install UNIX Client Software.
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5 In the Install UNIX Client Software window, click on the appropriate client
names in the Don’t install these clients list to select the clients you want to
install. Then, click Add >>.

The clients are moved to the Install these clients list.

6 To start the installation, click Install Client Software.

You cannot stop the installation after it has started.

Client software installation can take a minute or more per client. NetBackup
writes messages in the Progress field as the installation proceeds.

During installation, NetBackup copies client software from
/usr/openv/netbackup/client on the server to /usr/openv on the client.

If the installation fails on a client, NetBackup notifies you but keeps the client
in the policy.

7 After the installation is complete, click Close.

Installing client software with the ftp method
Before you perform this procedure, read the following guidelines:
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You must have a login ID and password that you can use to
access the clients through FTP.

Access to clients

If you want to install client software to a location other than
the default, you must first create and link the desired
directory. Create the directory where you want the software
to reside, and then create /usr/openv as a link to that
directory.

Client software location

Make sure that the clients are assigned to a backup policy.Backup policies

By default, this operating system version does not enable
the FTP daemon (ftpd), which is required. To enable the
daemon, run the following command:

launchctl load -w

/System/Library/LaunchDaemons/ftp.plist

Macintosh OS X

To install client software from a UNIX master server to UNIX clients with the ftp
method

1 To move the client software from the server to the /tmp directory on the
client, run the install_client_files script on the NetBackup server.

Use one of the following commands:

■ To move software to one client at a time, enter the following command:
/usr/openv/netbackup/bin/install_client_files ftp client user

The client is the host name of the client.

The user is the login ID that FTP requires on the client.

■ To move software to all clients at once:
/usr/openv/netbackup/bin/install_client_files ftp ALL user

The ALL option specifies that you want to install all clients that are
configured in any backup policy on the server.
The user is the login ID required by FTP on the client.

If you have not set up a .netrc file, the install_client_files script
prompts you for a password for each client.

2 After the script runs, the root user on each client computer must run the
following script:

sh /tmp/bp.<pid>/client_config

The pid is the process ID. The client_config script installs the binaries.
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Installing client software with the ssh method
This client installation method is based on the usage of the SunSSH and the
OpenSSH products, which must be at specific version and patch levels. For more
information about these patches, please refer to the Symantec NetBackup 7.5
Release Notes, Chapter 3: Product dependencies, Table 3-1.

Before you perform this procedure, read the following guidelines:

To use the ssh method, the UNIX client must have sshd
enabled and configured to allow root user logins.

SSH daemon (sshd)

If you want to install client software to a location other than
the default, you must first create and link the desired
directory. Create the directory where you want the client
software to reside, and then create /usr/openv as a link
to that directory.

Client software location

Make sure that the clients are assigned to a backup policy.Backup policies

By default, this operating system version does not enable
sshd. You must first enable this daemon to perform the
following procedure successfully.

■ In the System Preferences pane, select Sharing.

■ Select Remote Login to enable sshd.

Macintosh OS X

To install client software from a UNIX master server to UNIX clients with the ssh
method

◆ On the NetBackup server, run the install_client_files script.

Use one of the following commands:

■ To move software to only one client at a time:
/usr/openv/netbackup/bin/install_client_files ssh client

The client is the host name of the client.

■ To move software to all clients at once:
/usr/openv/netbackup/bin/install_client_files ssh ALL

The ALL option specifies that you want to install all clients that are
configured in any backup policy on the server.

Installing client software with the sftp method
This client installation method is based on the usage of the SunSSH and the
OpenSSH products, which must be at specific version and patch levels. For more

151Installing NetBackup client software
About NetBackup client installation on UNIX



information about these patches, please refer to the Symantec NetBackup 7.5
Release Notes, Chapter 3: Product dependencies, Table 3-1.

Before you perform this procedure, read the following guidelines:

To use this method, the UNIX client must havesshd enabled
and configured to allow root or non-root user logins.

SSH daemon (sshd)

If you want to install client software to a location other than
the default, you must first create and link the desired
directory. Create the directory where you want the software
to reside, and then create /usr/openv as a link to that
directory.

Client file location

Make sure that the clients are assigned to a backup policy.Backup policies

By default, these operating system versions do not enable
ssh. You must first enable this daemon to perform the
following procedure successfully.

■ In the System Preferences pane, select Sharing.

■ Select Remote Login to enable sshd.

Macintosh OS X

To install client software from a UNIX master server to UNIX clients with the sftp
method

1 To move the client software from the server to the /tmp directory on the
client, run the install_client_files script on the NetBackup server.

Use one of the following commands:

■ To move software to one client at a time:
/usr/openv/netbackup/bin/install_client_files sftp client user

The client is the host name of the client.

The user is the login ID that SSH requires on the client.

■ To move software to all clients at once:
/usr/openv/netbackup/bin/install_client_files sftp ALL user

The ALL option specifies that you want to install all clients that are
configured in any backup policy on the server.
The user is the login ID required by FTP on the client.

2 After the script runs, the root user on each client computer must run the
following script:

sh /tmp/bp.<pid>/client_config

The pid is the process ID. The client_config script installs the binaries.
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Adding a UNIX client after initial server installation
You may want to add UNIX clients after the server installation if you forgot to
select one during the installation. You may also add a new UNIX client type to
your backup environment.

To install client software later, you must first install the NetBackup client software
onto the NetBackup server.

To add UNIX client types to servers after initial installation

1 Use one of the following methods to start the installation script:

■ Insert the NetBackup UNIX Clients DVD into the
drive.

See “About the NetBackup media kit” on page 28.

■ If necessary, mount the DVD.

■ Enter the following command:

cd_directory/install

The cd_directory is the path to the directory where
you can access the DVD.

DVD

■ Navigate to the location where the installation
images reside.

■ Enter the following command:

./install

ESD images (downloaded
files)

2 When the following message appears, press Enter to continue:

Installing NetBackup Client Software.

Do you wish to continue? (y/n) [y]

The client binaries represent the operating system versions where the binaries
were compiled. The binaries typically function perfectly on later versions of
the operating system. For example, HP PA-RISC 11.11 binaries also are used
on the HP PA-RISC 11.23 level of the operating system. The installation
procedure attempts to load the appropriate binaries for your system. If the
script does not recognize the local operating system, it presents choices.
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3 Select the client type that you want to load and follow the prompts to install
that client type. Repeat as necessary until all of the client types you want are
loaded.

Make sure that you load the software for all of the UNIX client types that you
intend to install remotely from the server.

4 After the installation is complete, unmount the DVD.

5 Install the NetBackup client software on the clients you specified.

See “About remote installation methods for UNIX clients” on page 145.
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Removing NetBackup client
software

This chapter includes the following topics:

■ About NetBackup software removal on UNIX clients

■ Removing NetBackup Windows client software

About NetBackup software removal on UNIX clients
Use the following guidelines when you remove NetBackup from UNIX clients:

When you remove NetBackup client software, PBX is not removed. You must
remove PBX manually. The client software removal procedure in this document
includes a step that describes how to perform this task.

Warning:Do not remove PBX if your client uses other Symantec software products
that require PBX to run.

Removing NetBackup from UNIX clients
Use the following procedure to remove all NetBackup client software components
from a UNIX client.

To remove NetBackup software from a UNIX client

1 Log in to the client system as the root user.

2 Stop the NetBackup daemons by entering the following command:

/usr/openv/netbackup/bin/bp.kill_all
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3 Identify any installed add-on products by using the following command:

lslpp -LAIX

swlistHP-UX

rpm -qaLinux

pkginfoSolaris

Remove each identified add-on product.

4 To unregister NetBackup from the VxUL master configuration that is stored
in the /etc/vx/vrtslog.conf file, run the following command:

/usr/openv/netbackup/bin/vxlogcfg -r -p 51216

The -p option specifies the product ID, which is 51216 for NetBackup.

5 To unregister all NetBackup products with LiveUpdate, enter the following
command:

/usr/openv/netbackup/bin/nblu_registration -r

6 For the clients that support the PureDisk agent, remove all PureDisk files
with the following command:

/opt/pdde/pddeuninstall.sh -forceclean

7 For the clients that support the NetBackup-Java Display Console, remove the
console with the appropriate command as follows:

installp -u SYMCnbjavaAIX

swremove SYMCnbjavaHP-UX

rpm -e SYMCnbjavaLinux

pkgrm SYMCnbjavaSolaris

8 For the clients that support the NetBackup Java Runtime Environment (JRE),
remove JRE with the appropriate command as follows:

installp -u SYMCnbjreAIX

swremove SYMCnbjreHP-UX

rpm -e SYMCnbjreLinux

pkgrm SYMCnbjreSolaris

Removing NetBackup client software
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9 For native package clients, remove the NetBackup client by using the
appropriate commands as follows:

installp -u SYMCnbcltAIX

swremove SYMCnbcltHP-UX

rpm -e SYMCnbcltLinux

pkgrm SYMCnbcltSolaris

10 Remove PBX with the appropriate native command as follows:

Note: Remember, do not remove PBX if your client uses other Symantec
software products that require PBX to run.

installp -u VRTSpbxAIX

/opt/VRTSpbx/bin/vxpbx_exchanged stop

rm -rf /opt/VRTSpbx

rm -rf /etc/vx/VxICS

Debian

pkg_delete VRTSpbxFreeBSD

swremove VRTSpbxHP-UX

rpm -e VRTSpbxLinux

/opt/VRTSpbx/bin/vxpbx_exchanged stop

rm -r /Library/Receipts/VRTSpbxApp.pkg

rm -r /opt/VRTSpbx

rm -r /etc/vx/VxICS

rm -r /usr/share/man/man1/pbxcfg.1

rm -r /Library/StartupItems/vxpbx_exchanged

Macintosh OS X

pkgrm VRTSpbxSolaris

11 For all clients, navigate to the /usr/openv directory and proceed as follows:

Warning:The rm -f /usr/openv command also removes any add-on products
that are installed on this computer.
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■ If /usr/openv is the actual directory, run the following command:

rm -rf /usr/openv

■ If /usr/openv is a symbolic link to that directory, run the following
commands:
cd /usr/openv

pwd

ls

Warning: Before you continue, make sure that you are at the correct
location and verify that the subdirectories are what you expect them to
be. To help prevent removing the wrong directories, the previous
commands verify your current location and list the files in that directory.
After you verify the directory location and its contents, remove the
directory with the next commands.

rm -rf *

cd /

rm -f /usr/openv

12 For Linux systems only:

If you modified the startup and the shutdown scripts, run the following
command:

/sbin/chkconfig --del netbackup
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13 Remove the following startup scripts:

/etc/rc.netbackup.aix
AIX

/usr/local/etc/netbackup
/usr/local/etc/rc.d/S77netbackup.sh

FreeBSD

/sbin/init.d/netbackup
HP-UX

/sbin/rc1.d/K001netbackup
/sbin/rc2.d/S777netbackup

/etc.init.d/netbackup
/etc/rc0.d/K01netbackup

Linux Debian

/etc/rc1.d/K01netbackup
/etc/rc2.d/S95netbackup

/etc/rc.d/init.d/netbackup
Linux Red Hat

/etc/rc.d/rc0.d/K01netbackup
/etc/rc.d/rc1.d/K01netbackup
/etc/rc.d/rc2.d/S77netbackup
/etc/rc.d/rc3.d/S77netbackup
/etc/rc.d/rc5.d/S77netbackup
/etc/rc.d/rc6.d/K01netbackup

/etc/init.d/netbackup
Linux SUSE

/etc/init.d/rc0.d/K01netbackup
/etc/init.d/rc2.d/S77netbackup
/etc/init.d/rc3.d/S77netbackup
/etc/init.d/rc5.d/S77netbackup
/etc/init.d/rc6.d/K01netbackup

/Library/StartupItems/netbackup/Resources/netbackup
/Library/StartupItems/netbackup/StartupParameters.plist
/Library/StartupItems/netbackup/netbackup

Macintosh OS X
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/etc/init.d/netbackup
/etc/rc0.d/K01netbackup
/etc/rc1.d/K01netbackup
/etc/rc2.d/S77netbackup

Other clients

14 For AIX systems only:

■ In the /etc/inittab file, remove the following NetBackup entry:

/etc/rc.netbackup.aix

■ In the /etc/rc.shutdown file, remove the following line:

/etc/rc.netbackup.aix stop

15 Remove Symantec LiveUpdate components as follows:

■ First, examine the following file to see if NetBackup is the only product
that uses LiveUpdate:
/etc/Product.Catalog.JavaLiveUpdate

■ If no entries in the file contain the string NetBackup, run the following
commands:
/opt/Symantec/LiveUpdate/uninstall.sh -a

rm -f /etc/Symantec.conf

Note: Before you remove the following product catalog file, make sure
that it is empty. The empty file size is equal to 0 bytes. If the product
catalog file is not empty, do not remove it because other Symantec products
still require it.

rm -f /etc/Product.Catalog.JavaLiveUpdate

16 To remove the NetBackup-Java application state data for the root account,
run the appropriate command as follows:

Warning: Do not insert a space between the slash character (/) and the period
or dot character (.) of "/.veritas". A space between these characters removes
all of your files from the root level and beyond.

■ To remove the NetBackup-Java application state data for the root account
for all releases, run the following command:
/bin/rm -rf /.veritas

Removing NetBackup client software
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■ To remove the NetBackup-Java application state data for the root account
for a specific release, run the following command:
/bin/rm -rf /.veritas/java/<version>

Where<version> is the six-digit NetBackup version number. For example,
NetBackup version 7.5 with no upgrades applied would be entered as
750000.

17 Inform NetBackup-Java users, that they can remove their $HOME/.veritas
directory and portions of the $HOME/.veritas/java directory.

The $HOME/.veritas/java and $HOME/.veritas directories contain
application state information, that is saved when the user exits
NetBackup-Java applications. The saved information includes table column
order and size. The process removes this directory for the root user only.

The common subdirectory in $HOME/.veritas/java/.userPrefs/vrts can be
removed.

18 If you enabled NetBackup Access Control, NetBackup created new files on
the clients and the servers that can be divided into the following categories:

■ Individual user files
Individual user cache files exist in their home directories (for example, in
$HOME/.vxss). Inform those users that they can remove the $HOME/.vxss
directory.

■ NetBackup application temporary files
NetBackup temporary files are removed with NetBackup.

Removing NetBackup Windows client software
Use the following procedure to remove NetBackup Windows client software.

To remove NetBackup Windows client software

1 If it is open, close the NetBackup Backup, Archive, and Restore interface.

2 Open the Windows Control Panel (select Start > Settings > Control Panel).

3 Select Add/Remove Programs.

4 Select Symantec NetBackup Client.

5 Click Remove.
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Configuring NetBackup

This chapter includes the following topics:

■ About NetBackup server configuration

About NetBackup server configuration
After all server software is installed, you are ready to configure NetBackup to
work with the robotic and the storage devices in your environment. Remember,
these devices must already be configured and recognized by the operating system
before you can configure NetBackup.

See “About storage device configuration” on page 41.

Use the following guidelines when you configure NetBackup:

The procedures for configuring master and media servers
are very similar. However, Symantec recommends that you
configure all server information such as storage devices
and volumes from the master server. Following this order
helps ensure that the master servers properly administer
the media servers.

Warning: Communication problems between the master
server and the media server do not prevent you from
running the configuration wizards. Therefore, do not run
the wizards on the media server until the problems are
corrected. If you run any of the wizards when a
communication problem exists, the master server cannot
recognize the information that you enter. You must first
correct the problem. After you correct the problem, run the
configuration wizards from the master server.

NetBackup Enterprise
servers
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■ Configure devices on every node in the cluster.

■ Start by configuring all storage devices from the active
node so that they work with NetBackup.

■ For a NetBackup failover server, attach all of the devices
to each node in the cluster on which NetBackup is
installed. Refer to the clustering vendor’s documentation
for information on how to migrate to another node.

■ Unless otherwise noted, configure NetBackup to use the
virtual host names of master servers and media servers
in the cluster.

For complete information on to how to configure an
add-on product to fail over, see theNetBackupClustered
Master Server Administrator's Guide.

Clustered environments

For initial NetBackup server configuration, Symantec recommends that you launch
the NetBackup Administration Console and click the GettingStarted icon. A series
of wizards guide you through the following configuration procedures:

■ Configure Storage Devices
See “About the Device Configuration Wizard” on page 166.

■ Configure Volumes
See “About the Volume Configuration Wizard” on page 168.

■ Configure the Catalog Backup
See “About the Catalog Backup Wizard” on page 169.

■ Create a Backup Policy
See “About the Backup Policy Configuration Wizard” on page 170.

If NetBackup is already configured and you want to change a specific area, click
the appropriate wizard on the NetBackup Administration Console.

For complete information on all of the NetBackup wizards and how to configure
NetBackup, see the NetBackup Administrator's Guide.

See “About storage device configuration” on page 41.

Starting the NetBackup Administration Console
Use the following procedures to open the NetBackup Administration Console to
configure NetBackup. The GettingStarted wizard guides you through the primary
configuration steps to make NetBackup function.
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Note: Other wizards are available from the initial NetBackup Administration
Console window that are not part of the GettingStarted wizard. For example, you
can configure disk pools or create a snapshot backup policy. See the NetBackup
Administrator’s Guide, Volume I for complete information about all NetBackup
wizards.

On Windows systems, if you clicked the checkbox LaunchAdministrationConsole
that appears at the end of NetBackup installation, you can skip this procedure.

To start the NetBackup Administration Console on Windows

1 Log on to the NetBackup server as the Administrator.

2 Click Start>Programs>SymantecNetBackup>NetBackupAdministration
Console.

3 To begin configuration, on the Administration Console, click GettingStarted.

The Getting Started screen appears and prompts you to begin device
configuration.

Note: If you still need to configure devices to work with the operating system,
close the wizard. You must first configure those devices as specified by the
device and the operating system vendors.

To start the NetBackup Administration Console on UNIX

1 Log in to the NetBackup server as root.

For clustered environments, log in to the active node as root.

If you need to run the user interface on a computer other than the NetBackup
server, log on to that computer. For UNIX systems, log in as root.

2 Enter the following command:

/usr/openv/netbackup/bin/jnbSA &

3 Enter the password for root.

For clustered environments, when you log in to the NetBackup Administration
Console, specify the virtual host name in the Host field.

4 Click Login.
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5 To begin configuration, on the Administration Console, click GettingStarted.

6 On the initial Getting Started screen, review the content and click Next.

The following screen prompts you to Configure Storage Devices.

Note: If you still need to configure devices to work with the operating system,
close the wizard. You must first configure those devices as specified by the
device and the operating system vendors.

About the Device Configuration Wizard
Before you can run backups, you must define your storage devices for NetBackup.
This wizard guides you through this process. However, you must be certain that
you have configured your storage devices correctly for your operating system.
NetBackup cannot function reliably unless devices are installed and configured
correctly.

See “About storage device configuration” on page 41.

For clustered environments, begin configuring all storage devices from the active
node. For a NetBackup failover server, Symantec recommends that you attach all
of the devices to every node on which NetBackup is installed.

For complete instructions, refer to the NetBackup Clustered Master Server
Administrator's Guide.

This wizard takes you through the following processes:

■ Scans the hosts for backup devices

■ Verifies the devices that were automatically detected

■ Verifies and corrects the drive configuration

■ Updates the device configuration

The wizard presents the following information when you configure devices:
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■ When the wizard displays the DeviceHosts screen, you
must specify the hosts on which to auto-discover and
configure devices (NetBackup Enterprise servers only).

■ When the wizard displays the Backup Devices screen,
confirm that the list of devices is complete and accurate.
If a known backup device does not appear in this list,
take the following action:

■ Verify that the backup device is physically attached
to the host.

■ Verify that all installation procedures specified by
the device and by the operating system vendor have
been performed successfully.

■ Verify that all drives correspond to the proper device.
If you need to move a drive, select the drive and drag
it to the correct location.

■ For clusters, ensure that you perform storage device
configuration on each node. Begin on the active node,
then move the NetBackup active node to another node
and perform the storage device configuration on that
node. Repeat for each node of the cluster on which
NetBackup runs.

Note:By default, robotic daemons and NetBackup add-on
products do not cause NetBackup to failover if they fail.
You can configure robotic devices and NetBackup add-on
products to fail over NetBackup if the robot or the add-on
product fails. Before you configure NetBackup to failover,
robots must be configured and recognized by the
operating system. For complete details about fail over
configuration, refer to the NetBackup Clustered Master
Server Administrator’s Guide.

Device configuration
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■ You define storage units from the Configure Storage
Units screen. If your system does not have a tape device,
you can store data on a disk by defining disk storage
units.

■ When you enter a path for a storage unit, the following
rules apply:

■ Use the correct path separators (forward slash (/) for
UNIX and backward slash (\) for Windows).

■ Use a colon (:) to specify a drive separation on
Windows platforms.

■ Use the following characters only:

Alphabetic characters (ASCII A-Z, a-z)

Numeric characters (0-9)

Miscellaneous characters: plus (+), minus (-),
underscore (_), or period (.)

Defining storage units

See “About the Volume Configuration Wizard” on page 168.

About the Volume Configuration Wizard
After you have configured your storage devices, the Getting Started Wizard starts
the Volume Configuration Wizard. However, if you only have disk storage
capability, NetBackup skips this wizard.

This wizard lets you initiate an inventory of each configured robot. NetBackup
automatically updates the volume database if it finds new robotic media during
the inventory. In addition, you can define new volumes for use in stand-alone
drives.

For complete information about volumes or volume configuration for stand-alone
drives, refer to the NetBackup Administrator's Guide, Volume I.

Note: For clustered environments, configure volumes from the active node.

This wizard lets you do the following tasks:

■ Select a device for volume configuration

■ Perform an inventory of the robot

■ Create new volumes

■ Create new volume groups

The wizard presents the following information when you configure volumes and
perform inventory:
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■ NetBackup conducts an inventory of the robot or the
device that you selected. To view the results after the
inventory has completed, see the Results: field.

■ After the device inventory has completed, the wizard
prompts you to identify which device slots contain
cleaning media.

If you upgraded NetBackup and have pre-existing
barcode rules, the barcode reader automatically detects
the designated slots for the cleaning media. If you do
not designate cleaning slots, NetBackup considers all
media (including cleaning media) as typical media and
tries to overwrite it.

■ After the inventory has completed, you are prompted to
identify which device slots contain cleaning media.

If you identify one or more slots as cleaning media in
the Identify Cleaning Media screen, you see the Robot
Inventory(CleaningMedia) screen. This screen displays
the results after the software updates the EMM database.

If you do not designate cleaning media, NetBackup
considers all media to be typical media (including
cleaning media) and tries to overwrite it.

Robot or device inventory

■ Specify the number of volumes for the device.

■ The wizard does not let you configure cleaning tapes for
standalone drives.

Standalone drives

When you specify multiple drive types, the following are
true:

■ Media that is written by one robot drive may not work
in any other drive. If this situation occurs, NetBackup
considers the robot to have more than one type of drive.

■ If the robot has more than one type of drive, the wizard
cannot inventory the robot.

Multiple drive types

See “About the Catalog Backup Wizard” on page 169.

About the Catalog Backup Wizard
The NetBackup catalog contains information about your configuration and the
locations of backed up files and directories. If a disk fails and your catalog is lost,
a catalog backup makes it easy to restore your data and resume your backup
schedule.

Therefore, you must configure a catalog backup policy before any data gets backed
up.
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This wizard lets you create a policy for an online, hot catalog backup. Online, hot
catalog backups can back up the catalog while normal client backups are in
progress.

A catalog backup policy lets you specify the following information:

■ The destinations for the catalog backup
A backup destination can be any configured storage device. For additional
disaster recovery protection, you can specify a second location for your catalog
backup.

Note: Although NetBackup supports catalog backup to disk, Symantec
recommends that you back up the catalog to removable media that gets stored
offsite.

■ When the catalog backup occurs

■ The location of the disaster recovery file that is needed to recover from the
catalog backup

Use the following guidelines to configure a catalog backup:

■ Configure a catalog backup policy before any other files or data are backed up.

■ For clustered systems, configure the catalog backup policy from the active
node.

For complete details about catalog backups, see the chapter "Protecting the
NetBackup catalog" in the NetBackup Administrator's Guide, Volume I.

For instructions on how to configure a catalog backup in clustered environments,
see the NetBackup Clustered Master Server Administrator's Guide.

About the Backup Policy Configuration Wizard
This wizard lets you define a backup policy for a group of one or more clients. For
clustered environments, configure the policy from the active node.

The wizard lets you specify the following:

■ Policy names and types

■ Clients

■ Files and directories to back up

■ Backup types

■ Backup rotations
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■ Starting times of backups

The wizard prompts you to choose the type of backup that you want a policy to
perform.

Table 8-1 describes the available backup types.

Table 8-1 Backup type descriptions

DescriptionBackup type

Backs up all files that are specified in the file list.Full backup

Backs up all the changed files that are specified in the file
list.

Incremental backup

Also referred to as a Differential incremental backup.

Backs up the files that have changed since the last successful
incremental or full backup. All files are backed up if no
previous backup has been done.

Differential backup

Also referred to as a Cumulative incremental backup .

Only the files that changed since the last full backup that
was successful are backed up. All files are backed up if no
previous backup has been done.

Cumulative backup

Initiated manually by a user to back up specific files.User backup

Use the following guidelines when you create backup policies:

■ The list that appears on the Client List screen of the Backup Policy Wizard is
a list of clients that are backed up. You can add, change, or delete clients from
the list.

■ You can select how often you want a backup policy to run for full or incremental
backups. In addition, you can select the retention period for the backups.

After you have completed the Backup Policy Wizard , you are asked if you want
to perform an installation verification test. To do this test, click the Activity
Monitor in the left pane of the NetBackup Administration Console. You can now
monitor the progress of the backup job.
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